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ACE Support 

 

ACE 7.1.0 is supported in many ways. The first level of support begins with the use of the on-line help 
information. A click on Help brings up the Help menu for support. Clicking on Contents brings up the 

browser based help file. In this help file under Contents are both a screen based traverse of the help 
information and this user‟s guide. An index and the capability to search are also available on all these 

help information. In addition in the Help menu the Current Topic can be selected. A section on the Help 
menu also tells us about the features of the on-line help system.  
 

The second level of support is provided at the www.goace.com web site. The web site can be accessed 
through any web browser and on computers which are on the web through the item on the Help menu.  

The www.goace.com web site is being developed as a charted path through all the questions and 
answers provided in the continuing support of ACE. The answers can refer to topics of the on-line ACE 
help, other web sites, and special instructions, whatever can be found to support ACE users. 

 
Finally, as a third, there is the purchased ACE support at the email support@goace.com  

 
Thirty days of support comes with the purchase of ACE. Beyond that time period, the user has many 
options for purchasing additional support. These options are described on the www.goace.com web site. 

Purchased support requires the serial number information contained in the Help menu under about.  
 

Users moving from versions of ACE prior to fourth quarter 2003 are provided additional support as 
deemed appropriate by SSGINDIA to assist them in moving to the new ACE. This policy also is 
described on the www.goace.com web site. 

 
   Note:  

 

Data from latest version of ACT which is using SQL Server, can be migrated as a separate 

service on payment – please speak to support@goace.com    

 

 
 
 
 
 
 
 
 
 
 
 

 

mailto:support@goace.com
mailto:support@goace.com
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New features in Ace 7.1.0 over Ace 7.0.99 
 
 Ace7.1.0 has an additional event apart from existing events called as OPPORTUNITY event. This is 

to be used for opportunity tracking by Marketing and Sales people. 

 

 Ace7.1.0 gives you an additional export, import facility to / From XML Format. Which means you 

can import/export Data from your handheld devise as well. 
 

 Ace7.1.0 has a very useful feature of scheduling Emails, which is very much necessary to send 
emails on birth days or anniversary or can be even used in email campaign. In earlier version ACE 
7.0.99 - if you schedule a Birthday (or an Anniversary) event it was just giving you an alarm but in 

Ace7.1.0 - you can schedule a birthday event along with an option of sending Best wishes to the 
customer through email on that particular day automatically. 

 

 Ace7.1.0 has new Calendar Interface, which has a very pleasant look and feel.  

 

 Ace7.1.0 has now a new Synchronizing ACE Contacts and Events feature with Microsoft outlook 

and Nokia Mobile phone. 
 

 Ace7.1.0 allows its users to upload images on the contact screen. Now you can see your contacts in 

front of you while speaking to them over ACE Dial facility. 
 

 Ace 7.1.0 provides a list of departments while adding / editing contact where they can select any of 
the departments they belong to. 

 

 Ace 7.1.0 users can setup the status of contacts like prospect / cold, warm, hot, new customer and 

old customer. 
 

 Ace 7.1.0 users can select the role of the customer like CEO / End User / Influencing person / 

Decision maker. 
 

 Ace 7.1.0 has now provided a facility of viewing the contact name in the time management screen. 
 

 Ace 7.1.0 is now provided with a new facility like online activation and deactivation. 
 

 Ace 7.1.0 is now provided with email verification for mail sending. If no mail id is present in the 
contact then it will display an error message. 

 

 Ace 7.1.0 is now provided with new facility like arranging the databases in alphabetical order.   

 

 In Ace7.1.0, new Global replace designs have a very pleasant look and feel. 
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ACE 7.1.0 User Guide 
 

SL N0 ITEM DESCRIPTION   PAGE NO 

1.0.0 ACE 7.1.0  Installation How to Install ACE 7.1.0 5 

1.1.0 Pre-Requisite Windows 2003, XP or Vista or 7, operating 

System. 

6 

1.2.0 Preferable Drive Some comments about the Microsoft 
protection of the "Program Files" folder. 

7 

2.0.0 Welcome to ACE 7 Features Of ACE 7.1.0 14 

3.0.0 Benefits of ACE 7 Tells about  advantages of using ACE 7.1.0 15 

 

User Functionality 
 

4.0.0 ACE7.1.0 Basics ACE Basics gives you detailed information 
about how to operate ACE. 

16 

5.0.0 Contact Screen-Overview Contact Screen you can access all functions 

which are available in ACE to the ACE user. 

25 

6.0.0 Contents Tells About Menus of ACE. It is as follows 
with Sub categories  

71 

6.1.1 Contact Screen It is the Main Operation screen. Here we 

enter the Contacts, Schedule our 
Appointments and Send Mailings. 

 

71 

6.1.2 File Menu Create and access new databases, Setup and   

maintain your databases. 
 

72 

6.1.3 Edit Menu Edit Contact records and memos, database 
moves and view group fields. 

 

73 

6.1.4 Schedule Menu Adds Events to your Calendar and Schedule. 
 

74 

6.1.5 Lookup Menu 

 

Lookup contacts by one of many indexes, 

and Query by Example. 
 

75 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

5 

6.1.6 View Menu View Contacts, Events, History Records and 

other screens. 
 

75 

6.1.7 Call Menu Dial up Contacts fast with Speed dial or log 
your phone calls. 

 

76 

6.1.8 Tools Menu Use the Calendar or Task Manager to plan 
your day. 

 

76 

6.1.9 Write Menu Print letters envelops and labels. 
 

 

76 

6.1.10 Report Menu Print Reports and Contact lists. 
 

77 

6.1.11 

 

Window Menu Arranging icons and selecting the form 
layout design 

77 

6.1.12 Help Menu How to use the ACE Contact Manager Help 

system. 

77 

7.0.0  Kick start It tells you the complete basic feature of  
ACE  

78 

 

Admin Functionality 
 

         8.0.0 Compressing Compress database to remove any deleted 

records 

       118 

9.0.0 Migration Migrating data from ACE6 to ACE 7.1.0. 
 

       118 

         10.0.0 Rebuild Indexes Rebuild your databases to keep your data 

happy and healthy 

       125 

11.0.0 Restoring Backup Restoring the back up data 
 

       126 

12.0.0 Taking Backup Taking the data backup for Ace. 

 

       127 

13.0.0 Upgrading ACE 

(Version 6 or Version 7.1.0) 
Information for Existing Ace users to upgrade 
to the latest Ace version. 

 

       129 

         14.0.0 Restrictions of operations for 

client server installation 

The list of restrictions for client server 
installation. 

134 
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1.0.0. ACE 7.1.0 Installation                                                                                                                                                    
 

                ACE 7.1.0 is installed from a single executable file, aceXsetup.exe, where X represents the major 
                version number of ACE (ace7setup.exe). Normally ACE can be downloaded from - 

                www.goace.com  
                www.ssgindia.com/downloading.aspx 
                www.regnow.com 

                And from several shareware sites. 
  

                A CD-ROM may be purchased with aceXsetup.exe on it if desired.  
 
Existing ACE Users – should take a backup of ACEDATA before uninstalling ACE. After which 

they may Re-install it from downloaded Ace7setup.exe.  
 

 

1.1.0. Pre-Requisite  

 

Windows XP 

Windows Vista 

Windows7 

Windows Server 2003 

Windows Server 2008 

Microsoft office 2007 

Nokia PC Suite (required only for synchronization) 

 

          And latest windows update of the machine from http://update.microsoft.com. 

 
  

       1.2.0 Preferable Drive                                                                                                    
 

If you have two drives and you are using Windows XP / Vista or Windows7, you may install ACE 

Contact Manager on the second drive as well. It is convenient for backups and upgrading your operating 
system disk. A User of  a PC desktop or laptop who  has only one partition or drive can install the ACE 
7.1.0 application on C drive or the single drive by running a  setup or installation process as “ Run  as 

Administrator”.  
 

But, a word of caution! Windows Vista and 7 does not allow writing   to C:\ProgramFiles\” or deletion 
of read only files on the C drive. We at Ace have worked hard to make these restrictions transparent to 
the user. This is why Ace has the "Works with Windows Vista” certificate and “Windows 7 Logo 

Certificate”. The testing to make sure these requirements are met has been accomplished, but Microsoft 
does make a lot of changes time to time as a security need of the users and hence it is advised to avoid 

C: drive. 

 

 

 

http://www.goace.com/
http://www.ssgindia.com/downloading.aspx
http://www.regnow.com/
http://update.microsoft.com./
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Installation Process 
    
 1. Right click on the ACE7setup.exe, wherever you have saved and select “Run as Administrator” 

 
 

 
  

 
 

2. The user will get the following Welcome window. Click on Next to proceed. 
 
 

 
                     

                                       
                                                                     

3. The screen below with the “License Agreement” requires a positive effort from the user to   
   click on the “I Accept” button, in order to proceed. 
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The choice of “Destination Location” (Installation Directory) is next. For a standalone computer or for 

a server, the default location of installation provided by the software makes a good choice as a 
directory of Installation. The user can also browse to find a drive on which to install ACE 7.1.0. It is 

advised to install on a drive other than C: drive, if possible . 

 
4. In the next screen, the user requires to enter the User Name and Organization and select the  

available Options. After that click Next to proceed for installation. 
 

                                  
 

 

    

 
5. Next are the “Program Maintenance Group” choices. Select the Maintenance type and then click 

on Next to Proceed. 
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            The three different options in the Program Maintenance screen are mentioned below. 
 

 Stand alone => one single system where ACE 7.1.0 is being installed and where the database 

                             will stay. 
 

 Admin        => The machine where ACE 7.1.0 administrator will be installed and where the 
                      central database will also be installed and there will be additional Ace clients. 

 

 Client        => Ace 7.1.0 should be separately installed on each client PC. No database will be  

                    installed on the Client Picas there will be a central database on the “Admin”  
                    PC. When ACE 7.1.0 runs for   the first time, it will ask the user to “Locate the  
                    Database” on the “Admin” system or any other system having ACE 7.1.0  

                    database in ACE 7.1.0 format. Once the database is located, the Client will  
                    continue to work. So there is flexibility and the client can switch over to  

                    different database simply by locating it.  
 
 

 
We will proceed now to explain the sequence of installation in the case of “Stand Alone”. 

 
 

6. Follow the screen carefully. Click on “Change” button to change the location of installation to D  

drive (or any other drive apart from C: drive or system drive). 
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7. The user is free to select any drive apart from the C system drive. Here we have selected the D  
drive. After selecting the D drive for installation, click on Next to proceed further.                    

 
 

                                       
 
 

8. Install ACE 7.1.0 in the Data Destination Folder or click Change to select a different folder. 

             Click on Next to continue. 
                                                
 

            
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

11 

 

 

8. The following screen appears. Click on the install button to install. 

 

                                                 
 
 

 

10. The Installation process begins. 
 
 

 

                                        
 

                                                         
                                                                                     

11. In the Install Shield Wizard, select the Checkbox “Launch Ace Contact Manager 7.1.0” and  

      click on Finish. 
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12. The ACE 7.1.0 Welcome Screen appears. Click on Continue 

 
 

 
 
 

13. This is the ACE Preference window. The General, Modem, Events and Internet Tabs are  
      discussed later in this manual. In the ACE Preferences window, it will ask for some 

      information and all information are not mandatory. But you need to input the 3 character  

      Initials of your choice and click on Save. Please do not forget the initial.                     
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14. The following window appears. Input the Initials and press Enter. 

 
 

 
 

      In case you forget your initial or password, use forgot password below password block.  
 

 
 

 
15. If you have selected the “Client” option while installing, and then have run ACE 7.1.0 for the  

      first time, it asks you to locate the database and then you have to feed in the initials. Click on  
      Browse button to locate the database on the “Admin” machine on your network -  
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16. Double Click on the Network drive and locate ACEDATA folder on “Admin” machine.  

 
                               

NOTE: If you have selected the option of Standalone application in the Program Maintenance   
window, then the following screens (Browse for Folder popup and Browse popup will not appear). 
                                           

 
 

17. Click on The finish button.            

 

 
  

 
 
 
 

 
 

1.3.0. Trial Version Display  
 

Until you register ACE, you will receive a Trial Version Display screen as shown below where a pop-up 
appears indicating about your evaluation period left from the date of start. 
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The screen reminds you that you have 45 days in the trial version. When you are ready to register, click 
the Register button. The Serial / Activation Number provided to you when you buy should never change.  

If for some reason your Activation Number does not Work, then please contact ACE at 
www.goace.com.  

 
But normally, when you contact ACE you will be asked for the Number of Users you wish to activate as 
well as the other data mentioned above. You will then receive an (five groups of six characters) 

Activation Number for registration. 
 

NOTE: Prior ACE users should remember that if they move their databases into an unregistered version 
of ACE, the limit of 30 contacts will defeat such efforts. 
 

                                                                                                                                      

If you click on the Register button the following popup appears. Feed in the details for the Ace 
registration.     

 

http://www.goace.com/
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1.3.1. Online Activation: 

 

After receiving the Activation Number fill in the particulars click on the Register over Internet button. If 

your device is connected to internet and the Activation Number is valid then Ace will be registered. 
If the device is not connected to internet then additional 30 days will be provided for Activation through 

internet.  
 
 

1.3.2. Deactivation: 

 

Users can Deactivate Ace from their computer that has been Registered Online any time and use the 
same Activation Number to Activate Ace in different or same computer. 
 

To deactivate click Help in menu bar, select Deactivate Registration. 
 

 
 

 

Note: Deactivation can only be validated when the system is connected to internet. DO NOT Deactivate 
without internet connection. 
 
 
 

 
 
 

 
 

2.0.0. Welcome To ACE 7.1.0 
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ACE is world's finest Windows Contact Manager Software for the IBM PC class of computers with the 
Microsoft Operating Systems. Take a few minutes to read this chapter for helpful hints on how ACE and 

this ACE Reference Manual are organized.  
 
If you have never used a contact manager, ACE may represent an entirely new experience for you. ACE 

is designed with Ease of Use in mind. It is a contact manager designed to help you take control of your 
organization. ACE is designed for managing the contacts of an organization.  

 
Using ACE, many users can access your organization‟s database simultaneously. If you wish, you can 
have many databases as well as many users. The key point is that ACE has an administrator category of 

users which allows these administrator users to control the ACE Environment. Additional users can be 
added whenever needed and you (being the ACE administrator) retain control.  

 
With ACE, you and your organization and all of its ACE users (if allowed), can do the following: 

 

a)   Manage contacts with History Tracking. 
b)   Analyze contact Leads. 

c)   Link to popular Word Processors. 
d)   Manage your Mail and Email Lists. 
e)   Prioritize Personal Tasks and Task Schedules. 

f)    Search instantly for data you need in the database. 
g)   Schedule Individual as well as organization Calendars. 

h)   Support your organization's Telemarketing. 
i)    Support your organization's Web Marketing and Newsletters. 
j)    Support your organization's Snail Mail Marketing and Newsletters. 

k)   Print Reports, Labels, Envelops, Postcards, Memos, Letters. 
l)    Auto Dial from the Contact database.   

m)  Schedule telephone calls. 
 
 

 

3.0.0. Benefits of ACE 7.1.0 
 

 

This ACE User's Guide contains detailed information about using ACE. It is available on the web and 
can be ordered as a printed manual at www.goace.com.  

 
Before you can operate ACE, you must have Microsoft Windows 2003 or XP or VISTA or 7 installed. 

This manual assumes that you already have a Microsoft Windows product installed and are familiar with 
the Microsoft Windows operating environment. It also assumes that you have Windows Office 2003, 
outlook 2003, Nokia PC Suite (only needed for synchronization) installed on your machine.  

 
As long as Microsoft provides WIN32 compatible between their operating system versions, ACE should 

work smoothly on the various versions in a single network. ACE will get better and better at adjusting 
for version quirk. ACE surpasses many other contact managers. Some of the benefits you'll find with 
ACE are as listed below: 

http://www.goace.com/
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1) Separate contact and Schedule databases: ACE allows you to create multiple databases. You can    
            Use a common schedule that spaces across several contact databases or use private schedules that    

            Only certain users can see. 
 

2)  Good Searching Technology: ACE uses good indexing technology to speed up finding and 

querying of records. This technology far surpasses existing search methods of many other 
contact managers. 

 
3)  Sub-Group Creation: ACE will allow you to create sub-groups quickly and easily. Using the 

query command, you can search for records and create a temporary sub-group. This sub-group 

can then be further searched using the Lookup command. 
                                                                                                                             

4) Unattached Scheduled Events: You can specify whether or not you want Scheduled Events 
attached to a particular contact record. ACE allows you to keep events separate or as part of a 
contact record. 

 
5) Eleven instant search methods: ACE allows you to instantly find your contact using eleven 

different search criteria. This is in addition to queries which allow you to search for and sub-
group your contacts in an unlimited fashion. 

 

6) Build in Correspondence Accessories: Automatically create email, postcard, address cards, 
phone books, letters, memos and many other types of multiple contact correspondence. 

 
7)  Links to Other Programs: ACE contains links to Word Processing, Email, Edit, Adjusting etc. 

applications from other popular software vendors. 

 
8) Hot Sheet (tm): ACE's Hot Sheet(tm) takes information from different areas of ACE such as Hot 

Contacts, To Dos and Appointments and then conveniently prints, emails or syncs to PDA's all 
the information in a single document. 

 

 
 

1.4.0. Pending Events Found 
 
 

Every time you load the ACE contact manager, the pending events are displayed. You have the option of    
Informing ACE to check your events database for past due events, pending events or never check. You     

Control this checking by accessing the EDIT->Preferences -> Event Preferences.        
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1.5.0. Typographical Conventions 
 

Before you start using ACE, it is helpful to understand the terms and typographical conventions used in 
this reference guide. There are a few standard text formats and paragraph alignments that are used 

throughout this users guide. They are listed below: 
 

 The word Selection or Select: This word is used when you are to select a choice on a 
menu. This could be with the mouse or with the keyboard. 

 

 Bold Type: Word or characters you type. For example, if this users guide instructs you to 
type John Smith {Enter}, you type the words "John Smith", and press the enter key. 

 

 Bold Type Button: When instructed to select a button with the mouse, or keyboard, the 

button is presented in bold type. For example, if you are to select the Cancel button, the 
text will look like this: Cancel. 

 

 NOTE: Notes are recognized by the word NOTE in all caps and bold face. 

 

 HINT: Hints are recognized by the word HINT in all caps and bold face. 

 

 {Enter}: When the "{}" brackets enclose a few characters the reference is being made to  
the key on the keyboard with that notation many times .When a specific keyboard key is 

mentioned, an icon of the key is shown such as the dollar sign key icon.  
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1.5.1. Menu Bar 
 

You should always be aware of the Menu Bar and the currently available options. If an option does not 

have a highlighted letter, then it is not available. This user guide terms the available options as "turned 
on." while unavailable options are referred to as "turned off”. You can use the mouse to click on a menu 
or use the Menu Key combination. The Menu Key is always the {Alt} key + the underlined key. The 

File menu can be accessed by pressing {Alt} F or by clicking on the word File with your mouse. 
 

 

1.5.2. Sequence of Steps 
 

Frequently, there is a sequence of steps that this user guide wants you to perform. The steps are listed 
below. Example: 

 

1. From the contact Screen select the Lookup Menu. 
2. Select the Company Option. 

3. Type: ACE {Enter}. 
 

 

4.0.0. ACE Basics 
 

ACE provides you with easy to operate menus and panels. If you are already familiar with the standard 
Windows user interactions, you can probably skim most of these topics which start with "ACE Basics". 

 

4.1.0. ACE Basics - On Line Help 

 

Help is almost always available to the user by pressing {F1}.Help is also available from the Menu Bar, 
by selecting {Alt} H on the keyboard or clicking on the Help on the Menu Bar. You can obtain more 
information on the Help menu by clicking below Help menu. 

  
4.2.0. ACE Basics – Controls 

 
Your mouse has a pointer that appears on the screen as an arrow. When you want to select something, 
you move the pointer to the item and press the left mouse button. Double left clicking on items is similar 

to clicking the OK button. 
 

4.2.1. Control Buttons 

 
Message boxes, List Boxes and Decision Boxes have Control Buttons to choose selections or answer 

questions. The buttons are selected by clicking them with the left mouse button or by pressing the Menu 
Key sequence. Remember the Menu Key is always the {Alt} key + the underlined key. 

 
4.2.2. Radio Buttons 

 

Many screens give you a multiple choice selection. In these instances your selection is indicated by a 
Radio Button and will remain in effect until changed. You can change a radio button by pressing the 
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{Alt} key and the underlined letter on the radio button choice or by clicking on the button with the left 

mouse button. 
 

4.2.3. Scroll Bars & Thumb 

 
Scroll bars provide a visual clue about the amount of information that is available in a window. The 

scroll bar appears on the right hand side of the window vertically whenever there is more information 
than can be displayed on the screen.  

 
They may also appear on the bottom of a menu as horizontal scroll bars. The scroll bar has a thumb, 
represented by a projecting square that moves up and down to indicate the location of the currently 

highlighted record in relation to the entire list. If the thumb is at the top of the bar, the record is at the 
top of the list. If the thumb is in the middle of the bar, the record is in the middle of the list. 

 
4.2.4. Moving with the Mouse 

 

The upward pointing arrow at the top of the scroll bar and downward pointing arrow at the bottom of the 
scroll bar lets you move up and down the list one line at a time. This is accomplished by using the 

mouse: 
 

 To move up one line in the current list, click on the upward pointing arrow with the left 

mouse key. 
 

 To move down one line in the current list, click on the downward point arrow with the left 
mouse key. You can move more than one line at a time using the scroll bar. This is 

accomplished by: 
 

 Grabbing the thumb with the mouse point and holding down the left mouse button. 
 

  As you move the mouse up and down, the thumb will also move along the scroll bar. 

 

 Release the left mouse button to stop scrolling and arrive at your destination. To move a 

page at a time, place the mouse pointer between the thumb and the arrow and press the left 
mouse button once. Placing the cursor above the thumb will move a page up, while placing 

it below the thumb will move one page down. 
                                                                                                                                                   

 

4.2.5. Moving with the keyboard 

 

Scroll bars can be operated from the keyboard by controlling the cursor with the arrow keypad. The up 
and down arrows moves the cursor up and down simultaneously. Holding the arrow key down scrolls 

the cursor through the list. {Page Up} and {Page Down} moves the screen one page at a time. The 
thumb always moves while scrolling with the mouse or the keyboard to indicate where the cursor is in 
relation to the entire list. 
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4.3.0. ACE Basics - Menu Boxes 

 

As a general rule, you may use the mouse to select any button or option in a menu by clicking once with 
the left mouse button. To move about a menu with the keyboard, use the {Tab}  and the {Shift} {Tab} 
sequence. {Tab} moves you forward ;{ Shift} {Tab} moves you backward to each option. Many times 

the {Space Bar} acts like a click of the mouse. 
 

 

4.3.1. Message boxes 

 

Message Boxes require a key press to let ACE know that you read the message. They will usually alert 
you to the fact that you cannot perform a requested function. After reading the message, click on the OK 

button or press {Enter} to clear the Message box. 
 

 

4.3.2. Decision boxes 

 

Decision boxes require you to give an answer to a question. Yes/No decision boxes give you up to three 
choices; Yes, No and Cancel. Selecting the button by clicking it or by pressing the {Tab}  to change and 
the {Enter} key when the answer you desire is highlighted. Selecting Cancel is identical to pressing 

{Esc}.You can also select a choice by pressing {Alt} plus the underlined key. 
 

 
4.3.3. Check boxes 

 

Check boxes indicate conditions that can be switched on or off. If a check box is switched on, a check 
will appear in the box. Click one with the left mouse button on the check box to change status. To 

change the status from the keyboard, use the sequence {Alt} plus the underlined letter or move the 
cursor to the check box using the {Tab} key and press {Space Bar} once. 

 

 

4.3.4. List boxes 

 
List boxes display information in a list format. When presented with a list box, you must make a choice 
from the list. Depending upon the operation; you may choose one or more items from the list. To select 

an item, using the mouse, move the mouse pointer to the item desired and click the left mouse button 
once. The item becomes highlighted. To select an item, using the keyboard, press the up or down arrow 

keys until the desired item becomes highlighted. 
 

NOTE: Many times by right clicking the mouse button in a menu, a "Fly Out" menu pops up. "Fly out" 

menus give you quick and easy avenues of accomplishing tasks. 
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4.3.5. Edit boxes 

 

Edit Boxes require you to "fill in the blank." Edit boxes frequently offer you additional choices that can 
be selected using check boxes or radio buttons. 

 

HINT: You can use the Popup function in many edit boxes to quickly fill in the field. While editing a 
field, double click the left mouse button on the field name or press {Shift} {Enter} to call up the 

associated Popup table. Popup Tables ensure accuracy by eliminating operator error while speeding up 
data entry. In addition, Popup Tables are useful in presenting frequently used choices such as cities, 
shipping methods, sales reps name, business types etc. 

 

 

 

4.4.0. ACE Basics - Menu System 

 

 

 
 

 

4.4.1. Choosing menu options 

 

ACE operates with an easy to use Menu system. Each operation available is listed at the top of the ACE 
contact Screen. Each item on the Menu Bar is available by one of three methods, using the Mouse, using 

the {Alt} key sequence (Menu Keys) or using Hot Keys.  
 
The screen has several important features which make accessing ACE's functions easier. The Menu Bar 

is the top line in the current window and always displays menu options available for the same. Menu 
selections are accessed by clicking with the mouse, or by pressing the {Alt} key and the Underlined 

letter. This is called a Menu Key and each menu choice has one unique Menu Key selection. 
 

4.4.2. Hot Keys 

 
Many menus have Hot Keys that instantly select an operation. For example, if you desire to immediately 

add a contact from the contact Screen the Hot Key sequence {Ctrl} A will immediately add a new 
contact. As you gain familiarity with ACE, it would be wise to learn the Hot Keys to access commonly 
used functions directly. 

  

4.5.0. Menu Choices Not Available 

 
Sometimes as you select menus, some options are not available. The options that are not available 
appear in very light text unlike the options that are available which are usually in dark bold text. 
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4.5.1. Choosing Menu Options with the Mouse 

 

 Point the mouse arrow to the choice on the menu bars and press the left mouse button. The 
drop down menu appears. 

 

 Point to the desired menu option and press the left mouse button. The menu selection will 

execute. You can drag the highlight to the menu option by holding down the left mouse 
button, then move to the appropriate selection and release the left mouse button. 

 

 
4.5.2. Choosing Menu Options with the Keyboard 

 

 Pressing the {Alt} key while pressing the appropriate Menu Key. For example, pressing 
{Alt} (Tools) displays the Tools drop down menu. 

 

 Press the Menu Key of the appropriate menu option from the drop down menu. 

 

 

4.5.3. Choosing Menu Options with Hot Keys 

 

 Some menu items offer Hot Key combinations to speed their execution. Hot keys are listed 

to the right of a menu option if available. 
 

 Press the Hot Keys as show to activate the selection and bypass the pull down menu. For 
example, pressing {F6} immediately pops up the ACE Calendar. 

 
 

 
 

4.6.0. ACE Basics – Miscellaneous 

 

 

4.6.1. Date and Time 

 
ACE uses the computers internal date and time for all time oriented functions. You can change the data 

and time through Control Panel from the Windows Stat button. 
 

 
4.6.2. Transporting 

 

If you, as an administrator, need to move your data from one computer to another you need to copy the 
ACE database files. Movement of data is limited to administrators. ACE cannot operate on databases 

located outside of ACE's root directory. 
  
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

25 

 

4.6.3. Privacy 

 

If the ACE option is allowed, on a network version there is a radio button that appears on many screens. 
This button says Private. If you check this button, the item will only appear with your log in codes. For 
example, if you add an event and check the Private radio button, this event will not appear on any other 

user's workstation. If you do not check the Private box, the event becomes Public. A public event is an 
event that everyone on the network can see. This feature can be disabled.                                                                                                                                                

 

4.6.4. Backing Up 

                                                                                                    

ACE comes with both Backing Up enabled and disabled by choice. If ACE is installed on a server, then 
ACE should probably be backed up as part of the server with the server backup program. If ACE is 

installed as an individual registered user (a network of one), then the ACE backup can be enabled. This 
backup procedure creates zip files which can be read with standard zip programs. Care must be taken 
with these files to ensure privacy. 

 
 

4.7.0. ACE Basics - What is ACE? 

 
Ace is a Contact Manager Database program that is designed to help run you organization. With 

powerful intuitive tools - 

 You can track everything you need about all of your contacts.  

 You can easily target and communicate with the correct contact.  

 You can use the build in scheduling features to insure proper communications on your part at the 

correct time.  

 You can query and sort through the contact data to produce professional quality reports.  

 You can instantly access needed information with the click of a mouse.  

 You can log emails, log phone calls, memos, notes and just about any information you gather 

about each contact. 
 

 
4.7.1. ACE Basics - What is a Database? 

 
You can think of databases as drawers in a file cabinet. ACE gives you the capability to have many 
different file drawers in your cabinet holding different information. The way you structure your ACE 

data will significantly impact how you work with ACE Contact Manager and the speed with which you 
can find your information. This User's Guide helps you create the best structure you can. 
 

 

4.7.2. ACE Basics - What are Multiple Databases? 

 
Keeping track of contacts you make and what transactions you have with these contacts is your daily 
concern. You will have several types of contacts each day. For instance, you might be doing business 

with several different types of people -- suppliers, customers, and business associates. ACE lets you 
keep track of a diverse range of contacts by separating them into multiple databases if you wish.  
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For instance, you can separate your suppliers from your customers and your customers from your 
business associates. The advantage to keeping multiple databases is that you can keep different sorts of 

contacts separate from one another without having to set queries and sub-groups. (Queries and sub-
groups are ACE ways of separating contacts in a single database). 
 

The disadvantage is that you will have to know which database holds which contact. When a contact 
communicates with you and you do not know which database contains the caller, it could create some 

hassles. You will have to search all databases or guess in which database the contact resides. 
 

 

4.7.3. ACE Basics - What are Groups? 

 

In addition to the possibility of separating contacts into multiple databases, ACE can also separate your 
contacts into group in the same database. In ACE these groups are called sub-groups. A sub-group can 
be established using any search criteria, on any field in the database. Using sub-groups lets you keep all 

your contacts in one database, while allowing you to work with a particular type of contact group. Thus  
You can concentrate on the subgroup and have the benefit of the single database. Groups are established 

by ACE Queries and ACE Lookups. 
 

 

4.7.4. ACE Basics - What Are Events? 

 

ACE is driven by Events. Events are individual action items which must be accomplished during your 
day. For example, an event is an Email, a Phone Call, a Meeting, a Follow Up, a To Do, a Social 
Activity, a Personal activity, Travel, a Birthday or an Anniversary. You want ACE to prompt you or 

perhaps nag you, concerning Event items.  
 

All events are kept in a separate database not connected to individual contact records or other contact 
databases. The advantage to this structure is that ACE will allow you to have multiple contact databases, 
yet have these separate databases share one common schedule of events.  

 
Events are supposed to trigger your reactions. Events cause you to do something. For examples you can 

use the Event Scheduler to remind yourself of a meeting with Mr. Beserkly   or perhaps to have the car 
washed. 

 

 

 

4.7.5. Private versus Public Events 

 
When using ACE in a single user environment, whether an event is public or private is meaningless. In a 

network environment, especially in an organization, you usually want your schedule of some activities 
to remain private. You do not wish other users on the network to see your events which are personal.  
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When you schedule an event, there is a check box which you can mark if the event is to remain private. 
Private events are relatively private. The organization ACE Administrator can provide reports which 

could include private events. In addition, if you were to leave an organization, then the events you 
entered into the database would have to be assigned to others for completion. Thus the events would not 
be so private. 

 
 

4.7.6. ACE Basics - What Are Contacts? 

 
Contact records are the main reason you purchased ACE. This is where you and your organization keep 

information about your clients, customers, vendors, friends, family, prospects, suitors, etc. A contact 
record is a collection of information such as First and Last Name, Address, Email and Phone numbers 

and other information you choose to keep.  
 
The ability to keep varied information is what makes ACE so powerful.  

 
Any information entered into a contact's record is retrievable at a later date. You create contact records 

as you need them. You can have a contact record for each person with whom you deal in your business 
and for everyone in your personal life. Each time you have a phone conversation with or perhaps an 
email communication from a person you can create a record and add them to the ACE database. 

 
 

4.7.7. ACE Basics - What about Queries versus Lookups? 

 
A query allows you to search your database using Boolean logic. With the query command you can 

lookup contacts by whatever criteria you specify. The difference between a query and a lookup is speed. 
Lookups are faster. All lookups use an indexed field and are therefore almost instantaneous.  

 
Whether you have 20 contact records or 20,000, the lookup speed is the same. Lookups are also limited 
to predefined fields of information. Queries let you search on any field in the database. You can search 

for greater than, less than, equal to, etc., using IF, AND, and OR statements.  
 

Basically the query allows unlimited searching. Depending on your search criteria, the query may be as 
fast as a lookup. It could also be much longer. Queries also take time to build, whereas Lookups are all 
on the ACE Menu Bar. 

 
 

 

4.7.8. ACE Basics - What Are Fields? 

  

A Field is one piece of information in a record. Fields hold characters, names, numbers, dates, Yes/No 
indicators, or memos. ACE's power gives you control of the fields. ACE contains 50 User Defined 

Fields plus User Defined Group Fields. These are in addition to the standard name and address types of 
fields. 
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User Defined signifies you can determine what the field is called, and what type of information the field 

holds. Because ACE gives you all these power, you can plan how to set up your database before actually 
using Ace Contact Manager. Fortunately, you can change your mind at any time if you find that the way 
you have defined fields does not accomplish what you wished.  

 
The User Defined fields are displayed 13 at a time using three alternate views. While you can switch 

instantly between views, you probably still want to consider which will contain what information since 
only one window can be on the screen at a time. The most frequently used information should be 
grouped together on the same view. 

 
 

4.7.9. ACE Basics - What Are Field Types? 

 

ACE field hold one of five types of information. These five types are as follows: 

  
Character: Any alphabet, number, or symbol can be in this field. For example,  

                    (ABCabc123!@#$%^&*()_+|:"<>?';,./). 
 

Numeric:   Any number, positive or negative, with up to sixteen digits can be in this type of field. The  

                   decimal point and minus sign are included in the sixteen digits limit. For example, 
                   (1200.2434, -23). 

 
Date:         Any six or eight place date can be in a date field. (12/1/03 or 12/1/2003). 

 

Logical:     A Yes/No choice or a True/False choice can be represented in a logical field. A True/False  
                   choice is displayed as a T or F. 

 

Memo:     The memo field holds up to 64,000 bytes of text. The memo field is similar to a character  
                 field in all other respects. Some fields are not defined as the field type you might expect. For 

                 instance, the Zip Code field is actually a character field.  
 

The only time you need to create a numeric field is when you plan to process the field with 
mathematical operations or statistical calculations. Since ACE sees no reason to add or subtract all the 
zip codes, ACE chooses to represent a Zip Code field as a Character field. ACE justifies this because 

some countries such as Canada use letters in the zip code field.  
 

ACE makes the Phone Number field a character field for the same reason. In general, any numeric type 
of field which needs to include characters should be set up as a character field. The advantage to 
specifying a Date field when possible as compared to a Character field is for the searching ability on a 

Date field. You can search between date ranges, for greater or less than Date values, etc. in Date fields. 
 

 
 
 

mailto:ABCabc123!@#$%^&*()_+|:"<>?';,./)
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4.7.10. ACE Basics - What are Sub-Groups? 

 
Sub-groups are a method of dividing your contact records into smaller groups. You do not need to keep 
contacts in separate databases to work with a selected group of contact records. Contact records can be 

separated into sub-groups in a number of ways. Each successive method reduces the number of records  
which will be displayed and available for view.  

 
You could think of sub-groups as layers on a cake. The entire database represents the largest layer. 
When you establish a sub-group, your view takes the entire database and limits the display to only those 

contact records which you wish to see.  
 

When you limit your view by a sub-group, the contact records which you choose not to display are still 
physically in your database; ACE just passes over them for you. Each time ACE begins, you are using 
the entire database you have chosen. As you begin your day, you can define a sub-group to limit the 

number of contact records available for viewing. When you define a subgroup as far as you are 
concerned your whole database is not limited to that layer.  

 
Look at a Sub-Group Example, you wish to view only the contact records in one state. Starting with a 
database of 1,000 contact records, you establish a sub-group for California (CA). ACE will now search 

the entire contact database for records in CA and ACE finds only the 140 contact records in CA. Now 
your active database is only 140 contact records. For you these are the only records ACE will see. As far 

as ACE is concerned, the other 860 records temporarily no longer exist. You have temporarily created a 
140 contact record layer. 
 

 

4.7.11. ACE Basics - What Reports Are Available? 

 
ACE comes prepackaged with many reports. These reports are all accessible from the Reports Menu. 
The Reports menu contains fifteen built in reports which can be customized in an infinite variety of 

ways. Many of these reports have a multitude of options which allow you to print in almost any style 
and page size imaginable.  

 
See the section on the Report menu in the topic Reports Menu. Reports enable you to output gathered 
information from the computer to paper or files for exporting.  

 
You can create address books, lists of contacts, scheduled activities by day, week or month, complete 

contact records, history items plus many more combinations. External report writers can be used to 
access ACE information. Microsoft's Crystal Reports is one of these report writers. 
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4.7.12. ACE Basics - What Word Processor? 

 

ACE 7.1.0 supports Microsoft's word processor. In the past ACE supported other word processors. If 
you have a need for word processor support beside Word, please let the people at ACE know? The Word 

Processor is chosen under Edit->Preferences-General. Currently the choices are "none" and "Microsoft 
Word". 

 
 

4.7.13. ACE Basics - Save, Cancel or Commit? 

 
When you make changes or add information to you ACE databases, you must save the data so that ACE 

can enter the data into the database. This is important because ACE has other users using the database at 
the same time as you are using it. In ACE, most menus and boxes in ACE have an OK button or a Save 
button. By selecting either of these buttons, the changes or additions you make are "committed" (or 

made a permanent part of your ACE database). You of course can later delete or change the additions.  
                                                                                                                                                               

The Cancel button is the reverse of the OK or Save button. If you make additions or changes that you do 
not wish to save, then select the Cancel button which appears on most menus and boxes. Many times 
pressing {ESC} accomplishes the same task.  

 
ACE protects itself from two people committing changes to exactly the same contact record at exactly 

the same time. So occasionally you will see that your changes did not enter the database ahead of an 
associate‟s change but after the associate‟s changes. 
 

 

4.7.14. ACE Basics - What Happens to Deleted Records? 

 
ACE conforms to the "xbase" dbf file standard. This standard is used in almost all systems which have 
the main database file with the ".dbf" extension. While there are many variations, one issue addressed is 

how deleted records are processed.  
 

ACE does not actually erase a record when it is deleted. ACE marks the record for deletion and removes 
the record from view to most operations. The record physically is still on the disk and in the database. A 
separate process performed only by an ACE administrator called "Rebuild" physically removes all 

deleted records and compresses the database for fast, efficient use. 
 

 

4.7.15. ACE Basics - What is Rebuilding? 

 

Rebuilding is an operation on the underlying files of ACE. Periodically you must rebuild, re-index and 
save your ACE databases. Rebuilding databases reconstructs the index files and permanently erases 

deleted records. This process can only be undertaken when no users are in the ACE databases. This 
process can only be undertaken by a user with administrator rights. 
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

31 

 

 
During the rebuild process, ACE checks that the main contact databases and their associated memo files 

are properly associated with each other. In every main contact database memo file, the ACE account 
number is stored as the oldest portion of the memo file. This allows ACE to connect the memo file to the 
contact file. This is called "double threading" by ACE. 

 
 

5.0.0. Contact Screen – Overview 
 

The ACE Contact Screen is your main screen and the center of activity. From the Contact Screen you 
can access all functions which are available in ACE to the ACE user. Some ACE functions are not 
available to the ACE user. These functions are reserved for the ACE Administrator.  

 
If you have a database open, when you access functions and complete them, you will return to the 

Contact Screen. The Contact Screen is divided into four sections (or parts) for purposes of this User 
Guide.  
 

For the remainder of this Contact Screen section in the User Guide, each section will be discussed in 
sufficient detail with links to more detailed information.  

 

 

 

5.1.0. Contact Screen - Menu Items 

 

The menu items and icon toolbars portion of the Contact screen is shown below. Icons are buttons which 
give you quick access to items. All of these items are also available through the menus. 

 

 
 

 

 

 

5.1.1. The Menu Items 

 
As you can see, the Menu Items of ACE are located at the top of the ACE screen. There are eleven 

items. Each menu item is discussed in its own chapter in this Ace User Guide. After the discussion, you 
are linked to the Screen Based How to Manual for instructions on how to use the menu items.  

 
The discussions are meant to provide intent, philosophy, hopes etc. which have not been placed in the 
How To manual. Listed below are links to both the How To and User Guide Discussions of the Menu 

Items. 
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 File - For how to use the File Menu, see File Menu. 
 

 Edit - For how to use the Edit Menu, see Edit Menu.  
 

 Schedule - For how to use the Schedule Menu, see Schedule Menu. 
 

 For the User Guide information pertaining to Events and their scheduling see Events - 
Current or Events - Historical and Scheduling Events as well as Time Management Screen.  

 

 Lookup - For how to use the Lookup Menu, see Lookup Menu. For a discussion of Lookup 

and Query, see Lookup and Query. 
                                                                                                                                                     

 View -   For more information on using the Views Menu, see Views Menu. 

 

 Call -    For how to use the Call Menu, see Call Menu. 

 

 Tools - For how to use the Tools Menu, see Tools Menu. 

 

 Write - For how to use the Write Menu, see Write Menu. 

 

 Report - For how to use the Report Menu, see Reports Menu. 

 

 Help - For how to use the Help Menu, see Help Menu.  

 

 Users - For how to modify Ace Contact Manager Users, see Adding a User 

 

 

 

5.2.0. Contact Screen – Events 

 

One important aspect of a contact manager is providing a means to ensure that the relationship with the 
contact proceeds under your control. Events are about how ACE helps you to achieve this goal.  
 

You need to know whom to contact; when to contact, and the reasons for the contact. You need to know 
when your meetings are scheduled, and when to follow up on previous conversations or 

communications.  
 
ACE Events appear on the Contact Screen as shown in the following screen shot. 
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Under Ace Preferences you can choose what events appear on the contact screen. You have four choices 
for Automatic Operations for events. 

 

 Move all Past due Events Forward until marked as finished. 

 Complete all Past Due Events as if the event finished. 

 Delete all Past Due Events. 

 Move all Past Due Events Forward. 

 Leave Past Due Events along. 

 
You can notice that each choice will produce a different result. For more information on events see 
“Events Display”. 

 

 

 

5.3.0. Contact Screen - Status Bar 

 

The status bar displays the status of many areas of ACE. Some status indicators pertain to the current 
Contact record. Other status indicators apply to the entire database. Most of the Status Bar is shown 

below.  
 
The bottom line on your contact screen is also considered part of the status bar. A brief description of 

the status items is provided in this topic, and then you are linked to a more complete description. 
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5.3.1. Order 

 

As you add records to an ACE database, the new records are added to the end of the computer file in the 
order in which they were entered. ACE has a number of predefined and user defined indexes. These 
indexes are the tools that keep the contact records in alphabetical order as you list or scroll through the 

contact records.  
 

The current index order is displayed on the status bar. When you move to the next or previous record, 
this Order determines which contact record will appear. The sort is always alphabetical; the field upon 
which your view of the database is based determines what you see next. In the screen shot above the 

Order is "First Name." 
 

 
5.3.2. Valid Records 

 

The Valid Records line displays the number of active contact records in the current scope of the sort and 
query. When no query is set, the number of contact records shown is the number of contact records in 

the entire database EXCEPT for the deleted contacts which have not been removed from the database by 
a database compression.  
 

In fact, the administrator can "undelete" these deleted records at any time until the file is compressed. 
When a query is active, this number may be smaller than the actual number of active contact records in 

the database. This is because the number is only showing the number of contact records in the current 
sub-group or query. 
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5.3.3. Scope 

 

The group of active contact record is displayed under Scope. Normally, the scope of the file is All 
Records. If a query is set, the scope changes to show that all records are not visible.  
 

To release a query, choose Every Record from the Lookup Menu (Lookup Every Record). The scope 
will return to All Records. 

 
 

 

5.4.0. Contact Screen - The Main Toolbar 

 

 

 
 

 
Two ACE rows of icons are shown above. Each row is called a toolbar. The top toolbar (or row) is 

called the Main Toolbar. The second toolbar (or row) is called the Contact Toolbar. Each icon on each 
toolbar will give an English Language description (called a "flyby") if the mouse cursor remains on the 
icon for several seconds. Listed below are short descriptions of these icons with reference to shortcut 

keys in the order in which they appear above. 
 

 

 

5.4.1. The Main Toolbar 

 
The main toolbar is always visible and each of its tools may be loaded concurrently. 

 

Open Database -  Open Database The shortcut key to open a database is {CTRL} {F9}. Use this 
tool to switch between databases if you have created more than one database. Ace always starts with the 

last database you used. 
 

Daily Calendar - The shortcut key for the daily view calendar is {F6}. This is the daily view of the 
calendar. This calendar view displays your daily events. 

 

Weekly Calendar -  This is the weekly calendar, displaying your events one week at a time. A 
whole week of events is displayed, so less detail is displayed for each day than on the daily calendar. 
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Monthly Calendar -  This is the monthly view of the calendar, where only the event description is 

displayed for each day. This view is useful to quickly see how busy your schedule is and to schedule a 
new event on a desired day. By selecting a day, the daily calendar is displayed. 

                                                                                                                                                                  

Yearly Calendar -  This is the yearly view of the calendar. The yearly view shows an entire year, 

and highlights days with events scheduled. By selecting a day, the daily calendar is loaded. 
 

Time Manager - The shortcut key for the Time Manager screen (TMS) is {F2}. The TMS displays 

all scheduled events. Select a range of events or all events, and quickly reschedule events here. The  
TMS can be loaded automatically each time you start ACE, so you are always aware of upcoming 

events. This automatic load is what prompts the question about events when ACE begins. 
 

Task Manager -  The shortcut key for the Task Manager is {Ctrl} {F3}. The Task Manager 

presents a prioritized to do list, with fields for tracking the status, due data, and priority of a task or 
project. 

 

Paper File Index -  The shortcut key for the Paper File Index is {Shift} {F5}. The Paper File Index 

manages a small database for tracking storage locations of paper documents. 
 

To Do List -  The shortcut key for the To Do list is {Ctrl} {F5}. The To Do list is similar to the Task 

list, but is more of a free-form list which can be prioritized. 
 

Exit - The shortcut key to exit ACE is {Alt} {F4}. Exit closes all ACE files and databases. Then the 
ACE program quits. 
 

Survey –  This Tool can be used mainly for Marketing campaign. 
 
5.5.0. Contact Screen - The Contact Toolbar 

 

Listed below are short descriptions of these icons with reference to shortcut keys in the order in which 
they appear above. The contact screen is the center of ACE and will usually be displayed at all times. 

The contact screen has its own toolbar with tools that can be used only on the contact screen. This 
includes such tools as the Write tool, the Dialer, or the Hot Sheet. 
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Save -  The shortcut key for Save is {Alt} {S}. The Save command saves changes made to a contact 

record. If you move to another contact record using First, Next, Previous, or Last, information will be 
saved also. Other users do not know about your changes until one of the above commands is executed. 

 

Print -  Complete Record The shortcut key for Print is {F9}. Print will print the current list, 

window, or screen. 
 

First -   First displays the first contact record in the database in the current index order and sub-

group. 
 

Previous -  The shortcut keys for the Previous contact record in the current index order are {Ctrl} 
{P} and {Page Up}. The Previous command moves the view on the screen back one contact record in 
the current index order and sub-group. 

 

Next -  The shortcut keys for the Next contact record in the current index order are {Alt} {J} and 

{Page Down}. The Next command moves the view on the screen forward one contact record in the 
current index order and sub-group. 

 

Last -    Last Record Last displays the last contact record in the current sub-group and current index 
order of the current database. 

 

Add -  Add/Edit Client Name and Address The shortcut key to Add is {Ctrl} {A}. The Add 

command adds a contact record to the current database. 
 

Edit -   Add/Edit Client Name and Address The shortcut key to Edit is {Ctrl} {E}. The Edit 

command opens the contact information window for the current contacts, where the contact name and 
address information may be changed. 

 

Delete -   Delete a Record The shortcut key to Delete is {Ctrl} {D}. The Delete command deletes 

the current contact record. You may also delete the current group of contact records, or the entire 
database with this command. It is possible to undelete whatever is deleted until the database is 
compressed. 

 

Lookup -    Lookup The shortcut key for Lookup is {Ctrl} {F}. ACE will search for records using 

the current index order. A Lookup is faster than a Query. 
 

Query -   Query by Example The shortcut key for Query is {Alt} {Q}. Use Query to locate and 

group records by common field information. 
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Other Screen -    Other Screen The shortcut key for Other Screen is {CTRL} {O} . The Other 

Screen command toggles through the three different views of the contact record. Three clicks and you 
return to the original screen. 

 

List Records -   The shortcut key for List Records is {F5}. The List Records command shows the 

contacts in a list format. You many choose the fields to list in the window and then print this window of 
customized field lists. 
 

Speed Dial - The shortcut key to dial the phone (Speed Dial) is {F7}. Speed Dial quickly dials the 
contact phone number and records the call in the history file. 

 

Form Letters -  The shortcut key for Form Letters is {F3}. ACE gives you a detailed list of every 
letter in the form letter library. Choosing one moves the form letter and the contact information to 

Microsoft's Word processor (assuming you have Word) for you. ACE places a note in each contact's 
History file after the letter has been printed. 

 

Invoice -   The ACE Invoices screen contains a pick list for your product inventory list, and keeps 

track of invoices for each contact. 
 

Create Email -  Create Email allows you quickly to compose and to send an Email message to the 

current contact. 
 

Inbox -   In Box allow you to view and process Incoming Email messages. 
 

Outbox -   Out Box allows you quickly to send Email messages which have been queued 

previously. 
 

Help -   The shortcut key for Help is {F1}. Use Help for access to on line, context sensitive help 
anywhere in ACE. 

 

 

5.6.0. Contact Screen – Fields 

 

The Fields section of the Contact Screen contains six fields in five different contiguous areas. The memo 

field, the sixth field for the User Guide, is not in a contiguous area but instead the memo field is located 
towards the bottom of the contact screen. The five contiguous areas are shown below.         
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5.6.1. Fields - Contact Information 

 

The Contact Information area of the Contact screen displays the name, organization name and address of 
the contact. These fields are shown in blue above. Two individuals may be added to each contact record 
-- the Primary and  

-- Alternate individual.  
Double-click the Contact Information area to edit the Primary and Alternate individuals. To view either 

of the individuals, select the Primary or Alternate radio button as appropriate in the Contact fields area.  
 
For more detailed information see Contact Information. 

 
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

40 

 
 

5.6.2. Fields - Phone Numbers 

 

The phone number fields are displayed on the top of the Contact Information fields as shown in blue 
border above. The phone numbers may be edited or added on the contact information screen and also 
may be added on the contact record edit screen.  

 
Other fields in the database may be formatted and dialed as phone numbers, but only these four fields 

can be dialed with the {F7} hot key ACE dialer. The ACE dialer will dial the first number displayed in 
these four fields. For more complete information see Phone Numbers. 

 

 
 

 

 

 

5.6.3. Fields - Email and Web Page Addresses 
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The Email and Web Page information is shown in blue below. When you enter an Email address for this 

contact, the email address appears below the phone number fields in the Email ID field.  
 

If more than one address has been entered for the contact, only the default is displayed. Click on the 
Email ID label to quickly access the list of Email addresses for the contact. The list of Email addresses is 
shown below. 

 

 
                           

                                                                                                                                                      

 
 

Likewise, when you enter a Web Page for this contact, the Web Page appears below the email field in 
the Web Page field. If more than one web page has been entered for the contact, only the default is 
displayed. Click on the Web Page label to quickly access the list of Web Page addresses for the contact. 

The list of Web Page addresses is shown below. 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

42 

 
 

5.6.4. Fields - User Defined Fields 

 

The ACE contact screen has three screens of User Defined Fields. These User Defined Fields are fields 
which you customize to your needs. There are 40 fields in all, divided over three screens.  

 
When setting up your database, you can plan by first determining the total number of user defined fields. 
Then you can plan where to display each of these user defined fields.  

 
This way you can organize the three screens of User Defined Fields to show what you want where you 

want it. Type the shortcut key {Ctrl} {O} to switch between the three screens.  
 
Type the shortcut key {Ctrl} {F8} to customize these fields. These User Defined Fields have a Field 

Name of USER01 to USER40. The color of the field information can be customized by User Defined 
Field. The Field Label Definition screen to customize the fields is shown below. For more complete 

information see User Defined Fields. 

 
 

 

5.6.5. Fields - Logical Fields 
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The logical fields appear to the left of the User defined fields. They are marked in blue in the above 
screen. These six logical fields are either turned "On" or “Off” by clicking its checkbox. Logical fields 

are excellent for separating your contacts into different categories.  
 
For example- Prospects, VIP Customers, Magazines, Beta, Reference and Free.  

 
 

Type the shortcut key {Ctrl} {F8} to customize these fields. These fields are customized on the same 
screen as are the User Defined Fields. These Logical Fields have Field Names of Y_N1 to Y_N6. The 
color of the Logical Field description can be changed by Logical Field. For more complete information 

see the topic Logical Fields. 
 

 
5.6.6. Fields - Memo Field 

 

The Memo Field is displayed at the right of every contact record. You can type directly into the memo 
field by clicking in it with the mouse. Double-clicking the memo field will open up a window and place 
a data and time stamp at the top.  

 
The shortcut key to open the memo filed is {Ctrl} {M}. The memo field is one of the most useful 

features of ACE. ACE presents the memo field on the contact screen. When you view a contact, you 
immediately see your last memo, often the most important piece of information, in you contact record. 
In addition, because it is always on the screen you are more likely to use it.  

 
Keep an ongoing history of the conversations, plans, and details about your clients in the memo fields. 

Use the memo search to search for information into the memo field. For more information see Memos. 
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5.6.7. Fields - Group Fields 

 
Not to be confused with sub-group, Group Fields are additional fields which are attached directly to 
your contact screen. These group fields let you group together contacts which share in common only a 

membership of a particular group. ACE lets you assign a contact record to one or more of 22 groups. 
Some example group field criteria could be as follows:  

 
 

 
                                                                                                                                                                                                                      
 
 

 
Referral to PR Firm 2003 AIIM Show attendees Holiday Card List Question Credit Risk Groups are 

Yes/No logical fields. A contact is either a member of a group or the contact is not a member of a group.  
 
Once you have marked contact records into groups, you can find them by using the Query command. 

The shortcut key for Group Fields is {Ctrl} {G}. The screen which appears is as follows: For additional 
information see Groups. 

 

 

5.6.8. Customize Toolbar 
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This toolbar helps in arranging the tools in proper order or the order which we like. We can add the tools 
from Available toolbar buttons to current toolbar buttons and we can move up and down to meet our 

requirement or we can remove the toolbar buttons from current toolbar buttons. 
 

 

5.7.0. Events – Current 

 

Current Events drive ACE. The Schedule Menu allows you to quickly create current events. Events can 
also be created and manipulated in other ways. In ACE current Events are usually just called Events. 

Events are individual items to be accomplished during the future -- be it a day, a week or a year.  
 
An event is such an item as a Phone Call, a Meeting, a Follow Up, a To Do, a Social Activity, a Personal 

activity, Travel, a Birthday, or an Anniversary. Event items are items which you wish ACE to track and 
bring to your attention when appropriate.  

 
All Events are kept in a separate organization database not connect to individual contact record or even 
an individual contact database. The advantage to this structure is that ACE will allow you to have 

multiple contact databases, and multiple users.  
 

Reports and oversight actions and the like can easily be administered on an entire organization. An 
integral part of contact management is keeping in touch with your contacts. You need to know whom to 
call, when to call, and the reason for the call.  

 
 

You need to know when your meetings are scheduled, and when to follow up on previous conversations 
or correspondence. Time is very important in business. ACE is designed to help you schedule important 
phone calls, to do item, tasks, meetings, follow ups, social activities, personal activities, and travel time.  

 
ACE also allows you to record birthdays, anniversaries and holidays. This attention to detail allows you 

to remain "in charge" of your contacts. ACE helps you provide a "good image" to your contacts. 
 
 

5.8.0. Public v/s. Private Events 
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All events in ACE are tracked for the benefit of the organization. This means that the events scheduled 

in ACE can be monitored and controlled. At the same time a tool as powerful as ACE needs to be 
available to track events of a more Private nature.  

 
ACE allows the organization to set up a special category of events which are private. This means that 
these events do not normally show up on ACE screen views. Of course, any event in ACE can and does 

show up on some reports. 
                                                                                                                                                                  

 

5.9.0. Event Types 

 

Events are meetings, phone calls, follow ups, letters, emails, faxes, etc. ACE keeps track of all you 
important dates and reminds you when you need to do things. An event driven database organizes the 

people of the organization and the contacts around the events in the mutual life of the organization and 
the contacts.  
 

Once an event is entered, ACE reminds you about it. Then ACE lets you remove it from view after the 
event is completed. ACE stores information about a completed event in a History file.  

 
ACE can always provide a History of events for you. ACE has at least eleven types of events which can 
be scheduled. In addition to using the Schedule Menu to set up these events, you have other ways to set 

up these events. Listed below is a brief description of each event type. 
 

Phone Call - The shortcut key for Scheduling a Phone Call is {F11}. Phone Call events are for calls, 
callback, recalls. This category of event can be used for all phone calls you wish to make. 
 

Quick Call - The shortcut key for Scheduling a Quick Call is {Shift} {F6}. The Quick Call event is 
identical to a Phone Call with one difference. A Quick Call has no time for the event to happen. ACE 

calls this "timeless”. When you select Quick Call, ACE immediately sets a Phone Call event for the 
current Contact and the current day, which a time or any message about the call. Use the Quick Call 
when you wish to be reminded to call someone back, but do not need to set a time or topic of the call. 

 
 

 

 

Meeting - The shortcut key for Scheduling a Meeting is {F12}. Meeting events are used when you need 

to schedule a meeting or appointment with one of your contacts. Whether your contact is coming to you 
or you are going to your contact, you can schedule a meeting to remind you of the appointment. In the 

Meeting event screen, there is space for a memo concerning the location of the meeting. 
 

Follow Up - The Follow Up event is used primarily to accomplish something after a previous encounter 

with a contact. 
 

To Do - The shortcut key for Scheduling and To Do is {Ctrl} {T}. To Do events are reminders to you of 
important items which need to be accomplished on a certain day. If you wish to accomplish something 
on a specific day, at a specific time, then you can set a To Do. 
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Social - Social events help you schedule parties, business outings, company picnics, or any other social 
activity. 

 
Personal - You can track Doctor Appointments, meetings with your accountants, and family events. 
These events would go under the heading of Personal events. These events are also assumed to be 

Private events as defined by ACE. 
 

Other - Events which do not fit into other categories can be marked here. 
 
Travel - Use the Travel event type to schedule travel time. This could be events such as driving, air 

travel, etc. 
 

Opportunity – It is used for opportunity tracking by Marketing and Sales people. 
                                                                                                                                                        

Birthday - If you plan on keeping track of contact Birthdays or have a personal database for friends and 

family, you can record each birthday using this event. Schedule the birthday and it will automatically 
repeat on the correct day each year. 

 
Anniversary - If you plan on keeping track of client Anniversaries or have a personal database for 
friends and family, you can record anniversaries using this event. Schedule the anniversary and it will 

automatically repeat on the correct day each year. 
 

Holiday – If you have any plans for holidays or if you want to keep note some of the public or future 
holidays for you or your friends, you can record it using this event. 
 

Group Schedule - If you wish to set up an event for a group on contacts, you can use Group Schedule. 
Group Schedule makes it easy to set the same event for each group of a group of contact records. A 

good way to use this function is to set a follow-up event for every contact you added to the database 
today. See Group Schedule. 

 

Sequenced Events - You can schedule multiple events at one time. For example, you may want to call 
first (Phone Call), send a package next and then follow up with a new contact. This can be accomplished 

here. See Sequenced Events. 
 

Finish Event - Finish Event allows you to complete an event. When completed, the event is placed in 

the database's history file for that contact. The event to be finished must be highlighted for this option to 
work. 

 
5.10.0. Ways to Schedule an Event 

 

You can schedule events in five different ways in ACE. 
 

Schedule menu - You can schedule an event from the contact record by using the Schedule menu. 
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Calendar - You can schedule an event from one of the four calendars in ACE. These four calendars are 

accessed by clicking on the desire calendar icon (Daily, Weekly, Monthly, and Yearly). 
 

Schedule Event window - You can list the contact record's scheduled events. You use View Scheduled 
Events to see the list of contact records. From here you can schedule an event. 
 

Time Management Screen - You can list all scheduled events from the Time Management Screen. 
From this list, you can schedule an event. 

 
Events - You can right click in the Events area on the contact screen. When you right click here, you 
can choose Add. To learn how to accomplish all of the above, see Schedule Menu. 

 

 

 

5.10.1. Schedule an Event 

 

All of the above bring up the Schedule an Event screen. To accomplish scheduling an event, see 
Schedule an Event. 

 

 

 

5.10.2. Scheduling Conflicts 

 

When you schedule an event in a time slot that is already occupied by another event you have scheduled, 
ACE will display the Conflict Alert Scheduling Conflicts. 
 

 

 

5.10.2.1. Date Finder 

 
In a date field, in addition to actually entering a date you can type T to enter today‟s date. You can use 

the {+} and the {-} to increase or decrease the date by one date. In addition you can click on the 
calendar icon next to the date field and it will bring up a calendar which you can manipulate with ease. 

See Date Finder. 
 
5.10.2.2. Time Finder 

 
In a time field you can enter the time or click on the time icon to use the Time finder to enter the time 

for events in even intervals. See Time Finder. 
 
 

5.10.3. Using ACE Preferences to Automate Events 

 

ACE has the capability of automatically deleting, completing, or rescheduling Events. You can tell ACE 
to automatically change old Events. Once you setup the Preferences, every time you load ACE on your 
computer, ACE will check to find old Events and change them according to your setup. See Preferences. 
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5.10.4. Events Shortcut Menu 

 
The Events in a contact screen contain a quick access menu called an Events Shortcut Menu. The 
Shortcut menu allows you to do all of the Event functions such as add, edit, delete and finish by just 

using the mouse on the contact screen. See Events Display. 
 

 
5.10.5. Events Alarm Clock 

 

ACE has an alarm clock function which helps to remind you of scheduled events. You can learn about 
this alarm clock at Alarm Clock. 

 

 

5.10.6. Finish Event 

 
When you complete an Event, ACE calls it "Finish Event". You use Finish Event to mark an event as 

finished (completed). This finish process removes the Event from the Scheduled Events and places it in 
the History log for the attached contact. Only events which are attached to contact records can be 
finished. With Finish Event the Current Event becomes a Historical Event. 

 

 

5.11.0. Events – Historical 

 
With Finish Event the Current Event becomes a Historical Event. ACE maintains a History database for 

each contact database. In this history database there is a history log for each contact record. This gives 
you the ability to quickly review all your past events with a specific contact.  

 
When you "Finish Event" you move the event from the organization wide Events database to the contact 
database specific history database. The History database keeps track of events as you finish them and 

removes them from the Events database.  
 

The History database also keeps track of letters and email which you send to the contact, call which you 
have made to the contact or just about anything which you wish to keep in the History database.  
 

You can add a record to the History database even if you do not have a corresponding Event scheduled 
for the contact. To create a History record, see History Record. List, Add, Edit or Delete History Events 

To learn how to list, add, edit or delete events from the history database see the how to section on 
History. 

 

 

5.11.1. Query the History File 

 
You can query the history file to find only history items which meet a certain criteria. This is 
accomplished from the View History menu. The Query allows you to subgroup the History database so 
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that only specific type of history items appears in your History List mode. For example, you wish to see 

a list of every phone call you made during a specific time period regarding a certain subject. Once a 
history file is unlocked you can query for history items across multiple databases. 

  
History items can be queried and then you can have the full records which the history item belongs to 
displayed in your database. For example, you wish to see every contact record to which you sent a 

gizmo demo. When you sent the demo packages out, you record to each contact's history that you sent 
the package.  

 
Two months have passed and now you wish to see the data for the contacts who received the demo. You 
query the history database and use the Query for Match Records option to bring up the corresponding 

contact records. To accomplish this see History. 
 

 
5.11.2. View History Items 

 

You can view history items in two ways. One way is to access a contact record which has history items. 
See status bar. Another way is through the view menu. View History. 

 
 
 

5.11.3. View All History Records (Lock/Unlock History View) 

 

The History list view is by default restricted to only history items attached to the current client. At some 
times, you may need to view all of the history items for every contact. This can be accomplished by 
using the Lock/Unlock icon. See History. 

 
 

 

5.12.0. Time Management Screen 

 

ACE's Time Management Screen gives you a global view or printout of your upcoming Events. If you 
need to view all of your scheduled activities in one easy to read screen, you should access the Time 

Management Screen. 
 
ACE can display the Time Management screen when you enter ACE. This choice is set in the 

Edit|Preferences|Pending Events item. ACE gives you a quick option when choosing to display the Time 
Management Screen each time ACE starts. The shortcut key for Time Management is {F2}.  

 
You can also click on the Time Management icon. From the Time Management Screen you can add 
scheduled events, add notes to scheduled events and access your To Do list. You can use the icons 

displayed on the upper left of the Time Management Screen to manipulate your events or To Dos.  
 

You must put the focus on the feature you wish to use to active the icons for that feature. For example if 
you wish to use the ADD icon to add to To Do, click in the To Do section first. You can also highlight a 
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listed event or To Do and right click on it to add a new event or To Do or to manipulate the one you 

have highlighted.  
 

If there are no events or To Dos listed, you can right click in the corresponding area and add an event or 
To Do. For more information, see Time Management. 
 

 

5.12.1. Lookup 

 
Lookup and Queries give you the ability to locate a contact record/records which have specific data in 
certain fields. There are two ways to locate record which contain specific data. The instant Lookup with 

one defined criteria and the Query.  
 

The Query gives you the ability to locate contact records by multiple criteria. ACE finds information by 
creating and using database indexes. An index directs the program to search for information in a specific 
way. 

 
Indexes are comparable to have a clutter of notes, names, and addresses on your desk then alphabetically 

arranging all of the notes, names and addresses into three separate card files. ACE uses six permanent 
indexes and five user definable (that is changeable) indexes to help you find records fast. The permanent 
indexes are as follows: 

 
Company Name - You can find any contact based on the contact's Company name. 

  
Last Name - You can find any contact based upon the Last Name of the individual associated with the 
contact. 

 
First Name - You can find any contact based upon the First Name of the individual associated with the 

contact. 
 
Phone - You can find any contact based upon the first Phone number. 

 
Memos - You can find any contact by searching for any word, letters or phrase in each contact memo. 

See Memos. 
 
 

Key Word - You can find any contact by searching every field except the memo field. This will search 
the entire contact screen for any words that you enter. See how to accomplish this at Key Word  

 

Lookup - You can learn about Lookup at Lookup. ACE comes packaged with five User Defined 
Indexes. These indexes allow you to find your contacts in a particular order. You can change User 

Defined Indexes to support your organization's needs. The screen below shows how easy this is. 
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The User Defined Indexes screen shows your existing five user defined indexes on the left. The screen 
shows the ACE client Database field list on the right. You select what field on the right you wish to use 

for the index on the left. You can setup your own user defined indexes. See Lookup By Setup Indexes. 
 

 

5.13.0. ACE Can Show List Box When Contact Not Found 

 

There is a setting in the Preferences menu which allows you to have ACE automatically show a list box 
when a contact is not found. You also could have ACE ask you if you wish to see a list box. If ACE 

does not find the contact and you do not have ACE set to automatically pop up the List of Clients 
window, you will be asked if ACE should show the List box. 
 

 

5.13.1. Snap Shot 

 
Snap Shot helps you when you are doing a lookup. Snap Shot lets you memorize a lookup so that you 
may return to those contact records without running your query again. This is especially useful if you are 

working with a sub-group of contact records and are interrupted.  
 

You may need to come back to this task later. Simply take a Snap Shot of the records the way they occur 
at the present. Then you can do what you wish. You can then restore the memorized lookup to continue 
where you stopped. This Snap Shot is discussed more at Lookup by User Indexes. 

 
 

 

 

 

 

 

5.13.2. Previous Lookup 

 
The Previous Lookup option is activated when you lookup a contact record. This option will toggle back 

and forth between the current record and the last record you looked up. If a query were active during one 
of the lookups, you will also toggle back and forth between queries. See Previous Lookup. 
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5.14.0. Query 

 
The Query lets you build a formula for finding a specific set of contact records in a database. Queries let 
you set a filter, allowing only those contact records which meet the requirements of the filter to be 

displayed.  
 

Queries are another one of the more important features of ACE.  

 
A Query is much like the Lookup command. You can search for contact records in your database. The 

difference is that the query is much more powerful in its search capabilities. The Query command lets 
you search on multiple fields all at the same time. 

  
- You can use AND, OR, and other conditional expressions.  
- You can search on fields which are empty,  

                               - Fields which contain a phrase,  
                               - Fields which are greater or less than a certain value,  

                               - Fields which have an exact manager. 
 
Or just about any combination which you can devise.  

 
When you set a query, your view of the database is reduced to the number of records which match your 

query. This is called a sub-group in ACE. This process appears to remove contact records from your file, 
but the process actually hides all the contact records which do not match the query. Only the query 
matching contact records are visible.  

 
Once you have the sub-group selected, you can continue to print labels, print letters, print reports, and 

send email from this sub-group. You could also search these sub-group contacts using the Lookup 
command.  
 

When you print contact records, reports, labels, or anything in query, the query only determines which 
contacts are printed, not what is printed.  

 
There are several ways to set a query in ACE. Use the method which works best for you and the 
information for which you are searching. These different methods and the links which explain them are 

as follows:- 
 

 
 

 Lookup/Group - Key Word Lookup. 

 Query a Field - Query Field Wizard. 

 Query by Example - Query by Example. 

 Advanced Query - Advanced Query. 

 Query Builder - Query Builder. 
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5.14.1. Query vs. Lookup 

 
The Query is different from the Lookup command that brings you to a specific contact record. When 
you use the Lookup command, the size of your view of the database does not change unless you use the 

Group button. You are only brought to a specific contact record and the database view sort order is 
changed. The Lookup search is always instant regardless of the size of your database. The Query search 

may take long if ACE can not optimize the query. Once a Query is set, you can still use the Lookup 
command to search for contact records in the query. The lookup command will only find contact records 
within the current queried sub-group. 

 

 

 

5.14.2. Query vs. Advanced Query 

 

The Query has almost the same functionality as the Advanced Query. The menus are much easier to use 
with a Query. The Advanced Query has more power. When you use a query, you simply tell ACE for 

what to search and in which field to search. ACE does the rest of the searching. The Advanced Query 
lets you manually build a query using database syntax similar to that used by Lotus. ACE recommends 
that you use the Query and ignore the Advance Query until you are familiar with the capabilities of the 

Query. 
                                                                                                                                                             

 

 

5.14.3. Optimizing Queries 

 
When you set a Query, ACE may find the sub-group instantly or take more time. When ACE needs 

more time, a Status Meter pops up to show you the progress of the search. The time ACE spends 
depends upon the fields which your query uses. If you set a Query on any field listed in the choices of 
the Lookup menu except Memo and Key word, ACE can optimize your Query. In other words, if you 

Query on any field which is indexed, ACE will optimize the Query. When ACE optimizes your Query, 
the sub-group is created instantly, regardless of the database size. 

 

 

5.14.4. Special Field Rules 

 
Some field in ACE contains a formatting mask. This mask allows you to type only the numbers when 

adding a phone number or only the numbers when entering a data into a date field.  
 
For example, when you use Query by Example to search a Phone Number field, do not type the dashes '-

', or parentheses '()', or spaces. Only type in the number(s) for which you search. You can search a Date 
field just about any way a date field appears. If you are searching a Date field of October 31, 2003 in 

2003, these are some of the ways you can enter this field: 
 

 Oct 31 
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 10/31/2003 

 October 312003 

 

 

5.14.5. Looking up Contacts in a Query 

 
After a Query is set, you can still use the Lookup command to find contacts. When you use the Lookup 

command inside of a Query, only the contacts in the query are searched. If the ACE Lookup command 
does not find any contacts in the current Query, you will be asked if you wish to search the entire 
database, thus turning the Query off. 

 
 

5.14.6 .Complex Query by Example 

 
Using the Query by Example is straight forward when you are only searching for a single item in one 

field. It is still easy to search for a few items in a few fields. You just type in that for which you are 
searching at each field. To search for more than one item in a single field require you to follow certain 

rules. 
 

AND 

 
As you type in information at each field of the Query by Example screen, ACE automatically uses the 

AND joiner between each entry. This means that every condition you type needs to be met in order for a 
contact to be added to the sub-group. For example, if you type 619 in the phone number field, and type 
Poway in the city field, both of the conditions must be true for a contact to be included in the sub-group. 

                                                                                                                                                               

OR 

 
The time you can use the OR join in a Query by Example is within one field. For example, if you want 
to search the Widget filed for the colors Red, Blue OR Green; you can do it. But if you want to search 

for Widgets which contain Red, OR Last Name contains Smith, you can not. Since Widgets and Last 
name are separate fields, in order to use the joiner OR you must use the Advanced Query. See advanced 

Query. 
 

 

 

 

 

 

 

5.14.7. Operators Available in Query by Example 

 

The following operators are available in Query by Example: 

 

 Equal to 

 Greater or Equal 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

56 

 Less or Equal 

 Between 

 Not Equal To 

 Contains 

 Does Not Contain 

 Not Empty 

 Empty 
 

See Query By Example. 
 

 

 

5.14.8. Saving a Query 

 
You do not need to save a query. However, if you plan to use a query more than once it is a good idea to 
save the query. Once saved, the query goes into a list holding all of your queries. You can access the 

saved query later by using the List button on the Query by Example screen. 
 

 

5.14.9. Turning a Query Off 

 

To turn off a Quick Query and access your regular database of contacts, you only need to Lookup every 
contact record on the Lookup menu. 

 
 

5.14.10. Editing a Query by Example 

 
Once you save a Query by Example, you can not edit the query unless you use the „Advanced query.‟ 

 
 

5.14.11. Advanced Query Usage 

 
The Advanced Query gives you complete unlimited searching ability with ACE. With the Advance 

Query you directly type the query syntax. The Advanced Query only needs to be used in a few 
situations. The situations are listed below: 

                                                                                                                                                       

 When you need to mix AND and Or statements together in the same query. 
 

 When you need to apply special Lotus or dBase functions to the search. 
 

 When you wish to search for information that is not contained on the Query by Example 
screen. 

 

 When you need to edit an existing query. 
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When you use the Advanced Query, you need to convert all the function to character format in order to 

optimize the query. See Appendix A for a list of all the possible functions and what these functions 
accomplish. Character fields generally should use the Upper () function to convert the fields to upper 

case.  
 
Numeric fields can use the Str() function to convert to character format. Date fields can use the DTos() 

function to convert to character format. The Advanced Query menu is only accessible from the Query by 
Example maple screen. See the explanation under the Query by Example and see Advanced Query. 

Good hunting! 
 
 

5.15.0. ACE Task Manager 

 

ACE has a Task Manager. In it you can manage tasks assigned to yourself and others to create a To Do 
list, reminders and keep notes. 

 

 

 
 

 
 

 
The Task Manager window shows your tasks in a list format. Individual entries are display in order of 
Priority. The highest priority tasks are shown first. You can browse the list using cursor keys, scroll bars 

or mouse.  
 
The ACE Task Manager uses numbers to assign priority. Items in the ACE Task Manager are displayed 

by Priority first and Date Due second. The highest priority is one (1).  
Normally only unfinished tasks are shown in the Task Manager display. However, all tasks are kept on 

file after completion, unless you delete them. The Task Manager displays the finished tasks when you 
press {Alt} {S} or click on the Show Finished check box.  
 

Normally, you would use Popup Tables when entering the Status information of tasks. Popup tables are 
accessed by double clicking on the field or by pressing {Shift} {Enter}. By using Popup tables, you will 
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help to standardize your entries. To learn how to move around the ACE Task Manager see Task 

Manager. 
                                                                                                                                                                

 

5.16.0. ACE Calendar 

 

ACE offers several views of your schedule, including four calendar views. You can learn about the other 
views of your schedule by reading about Time Management Screen and Scheduling Events. Each of the 

four calendar views (Daily, Weekly, Monthly and Yearly) shows a different calendar view of your 
schedule. Most calendar related functions are the same throughout these four views. 
 

 

5.16.1. Daily Calendar 

 
The Daily calendar displays a graphical representation of your day. A small view of the current month 
and the next month are shown. The current date is highlighted. Days with scheduled events are also 

highlighted. All Timeless (Timeless) events are listed in the Timeless box. The Expanded Day View to 
the right shows the day organized by time. You can set the hours of your work day in Preferences. Your 

Task List from the Task Manager is shown at the bottom left. To learn how to use the Daily calendar, 
see Daily Calendar   
            

 
 

 

 

 

 

5.16.2. Weekly Calendar 
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The Weekly Calendar displays seven days worth of events listed for each day of the week. The 

regarding line for each event is displayed in time order. A small view of the highlighted month is 
displayed with the current date highlighted. Days with scheduled events are also highlighted. The 

Expanded Day View shows the highlighted day organized by time. To learn how to use the Weekly 
Calendar, see Weekly Calendar. 
 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.16.3. Monthly Calendar 

 

The Monthly calendar displays the selected month with the regarding information for events displaying 
on each day. Holidays, anniversaries and birthdays are shown with icons. See Monthly Calendar to learn 
how to use the Monthly calendar. 
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5.16.4. Yearly Calendar 

 
The Yearly calendar displays the entire year, starting with January. This window appears on top of the 

other windows. See Yearly Calendar to learn how to use the Yearly calendar.       
           . 

 
       

5.17.0. Paper File Index 

 
ACE contains a Paper File Index capability to assist you in tracking the location of your paper 
documents. The ACE Paper File Index is a database for your office filing cabinets. It is easier to search 
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for the location of a file folder in your computer than to walk across the office to attempt to locate the 

file folder.  
 

Such questions as "Did you file it under Legal or Corporate Articles of Incorporation?” can be answered 
easily. Keeping the Paper File Index up to date protects the organization from the "runaway truck killing 
you" syndrome. Whether the organization is simply your personal living space, your family, or a legal 

entity, a Paper File Index is a good practice. 
 

                         

 
 

                                                                                                                                                                                            
 

Each card in the Paper File Index contains an Index, Category, Description and Memo Field. These 
fields are described below: 
 

Index - The Index is the original sort field. The index can consist of several words, but the first letter of 
the first word determines under which tab of the alphabet the item is placed. 

 
Category - The Category field is a further clarification of the Index. For example, if the Index is Credit 
Cards, the Category could be Visa, MasterCard, Amex, etc. 

 
Description - The Description identifies the location of the paper document in the index.  

 
Memo - Each entry in the Paper File Index can contain a large amount of support information. This 
information can be put here. 
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5.17.1. Searching the Paper File Index 

 
You can search the Paper File Index by Index, Category, or Description. You control which method is 
used in the search process. On the Paper File Index screen there are the Alphabet tabs, Index fields, 

Category fields, and Description fields. The default sort order is Index. You can click on the Category 
field or the Description field to list the entries by those fields. You can use the alphabet tab keys below 

the toolbar to search for the Paper File Index cards. You easily can print labels for file folder from the 
Paper File Index. To see all that you can accomplish in tracking paper documents see Paper File Index. 

 

 

 

5.18.0. Things To Do List 

 
The ACE Things To Do List is a simplified version of the task scheduler. This list helps support the 

"Things to do" side of the "Things to do; people to push" management model. This management model 
says that all tasks break into two groups -- people to push and things to do. Historically, "things to do" 

items do not have the leverage that "people to push" items have.  
 
So, you should usually do all your "People to push" items first. Regardless of your efforts to assign 

items to others, occasionally you will have "thing" items to do. They go here. When you add Things To 
Do items, you can enter a priority and the item to accomplish.  

 
Naturally the Who field represents the logged on person -- you. Things to do cannot be assigned to 
others. For more details, see To Do List. 
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5.19.0. Invoice System Overview  

 
The ACE Invoice System allows you to create a quick invoice for any of your contacts. This Invoice 

System is very basic and easy to use. The Invoice System starts with a list of invoices. 
 

 
 

 
How to use this list of invoices are described at Invoice System. Easy to use invoices are created when 

you click on  these invoices by default look like the following: 

 

 
 

 
But you have a great number of choices when you select Edit Preferences on an invoice. The Edit 

Preferences brings up your choices as follows: 
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To use this preference form, see Invoice Preferences. 

 

 

 

 

 

 

 

5.20.0. ACE Calculators 

 
Currently ACE has four calculators. So to use the calculators your first decision is to decide which one. 

You always start out with the standard calculator. If you click on "view" then you have the choice of 
switching to the scientific, programmer and statistic calculator.  

 

 

5.20.1. Standard Calculator: 
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5.20.2. Scientific Calculator: 

 

 
 

 

5.20.2. Programmer Calculator: 
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5.20.2. Statistics Calculator: 

 

 
 

 

 

 

 

5.21.0. Reports Overview 
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As you manage your contacts, the data you collect as the ACE database is built and as the ACE database 

expand becomes much more meaningful if you can accomplish the following types of activities: 
 

 Support your activities with lists. 

 Locate specific data. 

 Group similar data. 

 Review progress towards goals. 

 Summarize the data. 

 Mine data for trends. 

 
Regardless which activity you undertake, ACE reports conveniently provide you with a report on the 

activity. The power of this reporting action comes from the way ACE works. All reports utilize the data 
in the current scope of ACE.  

 
You set the scope with a Lookup or with a Query. Once the scope is chosen the report provides data 
from within the scope. Most of the sixteen built in ACE reports provide customization capabilities. If 

additional customization is required, ACE provides for "User Defined Reports". You can create and save 
a custom report form which contains the information for your choice of any or many of the fields in the 

ACE database.  
 
By using the ability to limit the scope of the data in the ACE contact database, you can be very selective 

as to the content of a custom report. The ACE User Defined Report results can be viewed in a screen 
viewer before or instead of being printed. The ACE built in reports and the ACE User Defined Reports 

can be printed to a file.  
 
Most users up a Generic Text Only printer in Microsoft Printer Setup Wizard as the destination for file 

printing. This makes whatever data you have in your ACE report available in a machine readable pure 
ASCII format. (You can also use the Export capabilities of ACE to create machine readable data to be 

exported from ACE). 
                                                                                                                                                     

 

 

 

5.21.1. Complete Record Report 

 
The Complete Record Report prints a single contact record or all contact records in a group. The 

difference is chosen by a check mark in the Print Group option on the ACE Printouts screen ACE 

Printouts Overview. To print the Complete Record Report sees Complete Record. 
 

                                                         
 

 
 
                                                        

 

                                                       Contact Record 
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Primary Address Alternate Address 

 

Task Scheduler 

 

 

 

 

 

Work: 

FAX: 

Home: 

Other: 

Email ID: 

Webpage: 

 

Alt Work: 

Alt Fax: 

Alt Cell: 

Alt Home: 

Email ID: 

Webpage: 

 

 

Folder One 

 

Category: Alt L to look for a contact 

Secretary: 

Business: 

Referral: Ctrl W to find a contact by 
a 

Product/Serv: single word - 
anywhere 

Job Function: 

Paper Type: Track TASKS by 
priority, due date, status, who   

Check out Ctrl F3 

 

Serial #: 

Vol Purch: 

Support Fee: For help on Email 

Merge 

Support Until: go Ctrl W Email 

Merge 

Register Date: 

Purch Date: 
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 Folder Three 

 

User27: 

User28: 

User29: 

User30: 

User31: 

user32: 

User33: 

 

User 34: 

User 35: Other Screen is CTRL+O 

User 36: 

User 37: 

User 38: 

User 39: 

 

  
                  

 

 

 

 

 

 

                                                                                                                                             

Logical 

 

Prospect- No 

VIP Cust.- No 

Magazine- No 

 

Beta- No 

Reference- No 

Free- No 

 

Folder Two 

 

Soc. Sec.:    -  - 

User15: 

User16: 

User 17: 

User18               

User 19: 

User 20: The help in ACE is very 

extensive -also 
support@goace.com 

 

User21: 

User22: 

User 23: 

User 24: 

User 25: Other Screen is CTRL+O 

User 26: 

 

mailto:support@goace.com
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                                  No Group Affiliations Scheduled Events 

 

Days Date Time Event Regarding 

 

 -2669 
days 

 

12-Sep-2001 

 

 430 

 

To do 

 

Buy ACE at 
www.GoAce.

com 

     

 0 days 

        

 

 

 

                                              Historical Records 

 

Days Date Time Event Regarding 

    -3 

days 

30-Dec-2008 08:58 am Email  

    -2 
days 

31-Dec-2008 10:22 am Email  

    -2 

days 

31-Dec-2008 10:22 am Email  

    -2 
days 

31-Dec-2008 10:22 am Email  

    -2 

days 

31-Dec-2008 10:22 am Email  

    -2 
days 

31-Dec-2008 10:22 am Email  

    -2 

days 

31-Dec-2008 10:22 am Email  

 

    -2 
days 

31-Dec-2008 10:22 am Email  

    -2 

days 

31-Dec-2008 10:22 am Email  

    -2 
days 

31-Dec-2008 10:22 am Email  
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5.21.2. Calendar Report 
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5.21.3. HotSheet™) Report 
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5.21.4. Scheduled Events List Report 

 

 
 
5.21.5. History Events List Report 
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5.21.6. Contacts List Report 

 

 
 

 
 

 
5.21.7. Contacts Memo Report 
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5.21.8. Address Book Report 

 

 
 

 
 
5.21.9. Task List Report 
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5.21.10. Paper File Index Report 

 

 
5.21.11. To Do List Report 

 

 
 

5.21.11. Hot Contacts Report 
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5.21.12. Invoice Report 

 

 
 

5.22.0. Windows Overview 

 

 Arrange Icons   In the contact screen the icons will be rearranged according to the  

                              alphabets i.e. A-Z. 

 Cascade            Through the Cascade feature, the contact window will appear in the  

                              minimized form. 

 Tile Horizontal  Aligns the display window/s i.e. contact screen in a horizontal format. 

 Tile Vertical      Aligns the display window/s i.e. contact screen in a vertical format.   
 

 

5.23.0. Duplicate Checking 

 

Use Duplicate Checking to verify or remove duplicate records. You may search on any of the Ace fields 
for the comparison. You should open the database to check before running a duplicate check.  

  
To check for duplicates:  

 
1. Select Duplicate Checking from the File menu. The Fields to Use in Duplicate Check dialog appears. 
    Your Ace fields are listed on the Ace Field List.  

 
2. Select the fields to use in the comparison.  Select the fields in the order you would like Ace to search. 

For example, if you want to verify the company name, then last name, then phone number, select the 
fields in that order. As you select the fields, they are moved to the Fields to Evaluate column.   

 

3. Select the Duplicate Action. Choosing Delete will delete any occurrence of the duplicate after the first 
instance of the record. Choosing List will list the records without marking them for deletion.   

 
4. Select Do Not Include Empty Fields when it is possible that all of the fields that you are searching on 

might be empty.   
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The above image is displayed click on start will take you to Contact list where you can delete or 

undelete the contacts. 
 

To undelete deleted records: 
 

 
 
1. Select Undelete from the file menu. 

      ACE searches for any records in the current database that have been deleted, and lists them with an 
asterisk (*) next to the Company and Contact Name. 

 

2. You may shrink the list to view the database records more easily.  
     Highlight the record in the list to view on the contact screen behind it. If you close the list, however, 

you will have to select Undelete from the file menu again to bring it back. 
 
3. Four buttons are available. 

    Undelete Will remove the asterisk (*) from the highlighted record. And will return the record to the  
    active records in the database. 
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Undelete All Will remove the asterisks (*) from all of the listed records, returning them to active 

records in the database.  
 

   Delete and Delete All will delete records that have been undeleted since you started the current 
undelete session. 

 

Delete Will delete a record that has been undeleted. 
 

Delete All Will delete all records on the list. 
 

4. Close the list when all changes have been made. 

    All records with an asterisk (*) will be deleted when the database is compressed. 
 

5.24.0. Change database structure 

 

Use this option to alter the structure of a database: Change the fields from their current type to be 

character, date or numeric fields, lengthen or shorten fields. It is highly recommended that you backup 
your database before altering its structure, because the changes you make will remain permanent. 

 
If you change a field from character to a date or numeric field, all field entries that are not the same as 
the new field type will be lost.   

 
For example, if you have a field containing the word "January" and then change that field to be a Date 

field, it will be blank.  If the field contained 01/01/1999, it will still contain the date after the 
conversion.   
 

Steps to perform Change Database Structure:  
 

1. File Menu -> Database Administration -> Change database structure, the below form appears click on 
Next. 
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2. The form displayed below appears. Click on Auto change. 
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3. Here you can change the structure for each field and click on next. 
 

                   
 
 

4. Click on finish will change the database structure. 
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5.25.0. User Administrator 

 

User Administrator can create number of users, edit or delete the users. 
 

Adding the new user 

 

To add a user to the existing Ace users:   
1. Select Add.  The Ace User Record Editor appears.   
2. The cursor appears in the user initials field.     

    Enter the initials, and hit TAB to move to the Username.   
3. Fill with all fields.   

4. When all details have been entered, press Save.   
 

To edit an Ace user entry 

1. Highlight the entry to be changed. 
2. Select Edit. The Ace Record Editor appears.   

3. Select the field to change and make the desired changes.   
4. Select „Save‟ to save the changes to the Ace user‟s record.   
 

 

To delete Ace users: 

1. Highlight the filer record to delete.   
2. Select Delete. You will be asked to confirm. Enter yes to delete the record, or press No to      
    keep it.   

 

 

Add Users 

 
Click on Users to add, change, or delete user access to the Ace program called.  This first user is 

assigned a folder Ace under the Users Folder. The trial version of ACE is set to allow 3 users. The first 
user is automatically setup the first time Ace is opened. 
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To add a new user: Select Add from the Edit menu.-Or-Select the Add button on the toolbar.  
                                  The Ace User Record box appears.   

 
To edit an existing user: 

 

1. Highlight the user to edit. 
2. Select edit from the Edit menu.-Or-Select the Edit button on the toolbar. The Ace User Record box  

    appears with the highlighted record information.  Make changes to the record and press save to  
    continue.   
 

 

To delete a user: 

 

1. Highlight the user to delete. 
2. Select delete from the Edit menu.-Or-Select the Delete button on the toolbar.  

    You will be asked to confirm deletion of the user.  Enter Yes to continue, or No to cancel. 
 

 
 
 

5.26.0. Data Exchange 

 

Bring outside data into Ace 7.1.0.  From within Ace, you can import from ASCII Text files, dBase and 

FoxPro files.  For importing from other file types, such as Biz*Base or ACT! For Windows.   
 

 

 

 

 

 

 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

84 

 

5.26.1. To import to ACE 7.1.0: 

 

1. Select Import from the File menu. 
 

      The Import Field Match window appears.  The ACE 7.1.0 field list shows the fields of the current 

database, listed alphabetically by the field labels.  The Fields to Import lists the fields of the import 
file, and is empty when the window first opens. 

 
2. Select Browse to choose the import file to use.   

 

      The File to Import window appears.  Type or select the drive and directory location of the file, and  
      the file name.  The default file types are: - ACE 7 Format (contacts.dbf) 

                                                                     - Delimited format (*.txt) 
                                                                       -  FoxPro/dBase format (*.dbf) 
                                                                       -  dBaseIII (*.dbf) 

                                                                    -  Excel (*.xls) 
                                                                  -  Xml (*.xml) 

                                                                  -  Outlook 
 
 

Select OK when the file is chosen. The import file name appears in the Import File Location box. 
 

Note: If your file does not have one of the above extensions, but is in one of the above formats,        
replace the File Name line with the correct name and extension, and select OK . 

  

3. The Fields to Import list displays the fields in the import file.  The fields are listed in the order 
they    appear in the file.  If your import file has no header, you will see actual data instead of 

field names.   
 
If this is the case, you may view other records in the database by using the scroll buttons at the 

bottom of the Fields to Import area.  If you are importing from a dBase, FoxPro, or ACE 7.1.0 
file format, deselect Show Field Names to view the data only, instead of the field names.  

  
4. When the import file is selected, the Matched Fields box appears on the screen. This is where 

you assign the import file fields to the ACE 7.1.0 file fields.   

 
Highlight a field in the ACE 7.1.0 file, and then highlight the corresponding field in the import 

file.  When both lists have a field highlighted, the Add button becomes active in the Matched 
Fields box.   
 

Select Add to add the import field to the ACE 7.1.0 database.  The ACE7 field name will appear 
under the heading ACE 7.1.0 Field, and the import file field will appear under the Import from 

heading.  Continue matching until you have matched all of the fields you wish to use.   
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Match only those fields that you want to import into the ACE 7.1.0 database.  If you do not want 

some of the fields, just leave them and the import will ignore them.  
  

5. If you are importing from a dBase type file, the Auto button becomes active.  This function 
allows you to match up fields with the same name without having to match them one by one.   
 

All fields with the same name that are left in the ACE 7.1.0 field list and the Import File field list 
will be matched up for the import.  There are two ways to use this function.  If there are fields in 

the import file that you do not want placed in the same fields in ACE 7.1.0, match them to the 
desired fields as described in step four above.   
 

Then select Auto to match the remaining fields.  Or, hit the Auto button first, then remove the 
fields that you don't want to be imported, or fields that you want matched differently.  Then 

continue matching the fields as in step four above.   
 

6. If you matched the wrong fields, or want to delete fields from the matched field list, highlight the 

 line containing the fields to delete.  The Remove button becomes active.  Select Remove to  
 return the selected fields back to their respective lists.   

 
7. Many people constantly update their database by buying mailing lists from outside data sources.  

If you will be importing from the same type of file over and over again, save the Matched Fields  

list for use in the future.   
       

           To save the Matched Fields List, select Save.  Select the drive and directory to hold the file, and  
           give it a valid DOS file name.  If you import the same file type again, retrieve the saved list and  
           you won't have to spend time matching the fields again.   

 
       If you have more than one database, it is a good idea to save the Matched Field list file in the 

       same directory as the database.  That way, if any of the field names are different between your  
       databases, the Matched Field list files will match up properly when you load the list. If all of your 

           databases are exactly the same, the same format can be used for all of them. 

 
8. When all of the fields are matched, select Import to begin importing the file.  A status bar will  

show the progress of the import, and the Import Field Match window closes. The records are 
indexed as they are imported, so your database is all ready to go! 
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       9. While importing from outlook, make sure you provide Ace the permission to access outlook, a 

           dialog appears while import is being done as shown below. 
 

 
 

 

5.26.2. To Export from Ace 7.1.0: 

 

Send your data out of ACE 7.1.0, in a number of different formats. The ACE7 file export will export all 
of the contact database fields, including the memos, to a file called aceexp.dbf.   
 

 

To export to an ACE 7.1.0 file: 

 
1. Select Export from the File menu. The ACE 7.1.0 Export File and Format window appears.   
2. The default file format is ACE 7.1.0 format.  The default file name is *.dbf.  Enter another name if  

    desired.   
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3. Select the drive and directory to store the file.   
4. Since you are exporting to an ACE 7.1.0 format, the field list and delimiter buttons are dimmed.   

    Select OK to start exporting the file. The Delimited export allows you to choose the fields to export, 
    and allows you to choose the delimiter.   
 

To export to a Delimited file format: 

 

1. Select Export from the File menu. The ACE 7.1.0 Export File and Format window appears.   
2. Select Delimited (*.txt) as the File Format.  The file name changes to *.txt. 
3. Enter a valid DOS filename in place of the asterisk (*).   

4. Select the drive and directory to store the file.   
5. Select Delimiter to choose a character to separate the fields in your output file.  The default and most 

commonly used delimiter is a comma (,).  Some software may require a different delimiter between 
the fields.  You may select on of the pre-set delimiters, or choose custom and enter one of your 
own.   

6. Select fields from the field list to export.   
7. Select OK when all parameters are set.  The specified file will be created and the records will be 

exported to the file.   
The dBase III and FoxPro exports allow you to choose the fields to export.   
 

To export to a dBase III or FoxPro file format: 

 

1. Select Export from the File menu. The ACE 7.1.0 Export File and Format window appears.   
2. Select dBase III (*.dbf) as the File Format.  The file name changes to *.dbf 
                                                             -Or- 

    Select FoxPro (*.dbf) as the File Format.  The file name changes to *.dbf. 
3. Enter a valid DOS filename in place of the asterisk (*).   

4. Select the drive and directory to store the file.   
5. Select fields from the field list to export.   
6. Select OK when all parameters are set.  The specified file will be created and the records will be  

    exported to the file.   
 

The „WinFaxPro file export‟ will export database fields to a file called ACEFAX.DBF.   
 
To export to WinFaxPro file and Talking Caller-ID: 

 
1. Select Export from the File menu. The ACE 7.1.0 Export File and Format window appears.   

2. Select WinFaxPro (ACEFAX.DBF) as the File Format.  The file name changes to ACEFAX.DBF.  
    Enter another name if desired.   
3. Select the drive and directory to store the file.   

4. The WinFaxPro format has pre-selected fields; therefore the field list button is dimmed.  Select OK to 
    start exporting the file.   
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To export to XML and Excel: 

 

1. Select Export from the File menu. The ACE 7.1.0 Export File and Format window appears.   
2. Select Xml (XYZ.XML) as the File Format.  The file name changes to XYZ.XML. Enter another 

name if desired.   

3. Select the drive and directory to store the file.   
4. You can select the fields which you want to export from the field list.   

 

 
 

To export to Outlook: 

 

1. Select Export from the File menu. The ACE 7.1.0 Export File and Format window appears.   

2. Select outlook. Here you don‟t have to give any filename. 
3. Make sure Outlook is installed before you export. 
 

 
5.27.0. User Defined Reports 

 

ACE has many custom reports built-in, but you may need reports on fields that are not included in the 
custom reports.   Use the ACE User Defined Report Builder to create reports specific to your needs.   

 
You can send your reports to your word processor where you can then add color, change fonts or styles, 

add annotations, and print professional looking reports in minutes! 
 
The User Defined Report is similar to the User Defined List, except the Report can have more than one 

line per contact, and you have more control over the formatting of a User Defined Report.  If you need a 
single- line type report, you may prefer to create a user defined list instead of a report.   
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To create a user defined report:  

 
1. Select Reports | User Defined Report.-Or- If the report writer is already open,  
2 Type the name of the report to create.  Reports have an extension of RPT.  Replace the asterisk (*)  

   with a file name of eight (8) letters or numbers, or less.  Hit [ENTER] or OK to create the report file.  
   (Example; SALES_Q1.RPT).   

 
   The ACE Column Editor appears with the following areas:  
 

Toolbar:   The Toolbar provides tools to move around in the columns, Add, Insert, and Delete 
                    columns, and also shows the number of columns, and the position in the columns.   

 
Report Title:    Enter the name of the report here.  This will appear at the top of the pages of the 

                            report.   

 
Column Heading:   Enter the heading that you would like to appear at the top of each column in the  

                                    report.  A heading can be entered for each column, and more than one line can be 
                                    entered for each heading.   
 

ACE Available fields:   In this section, you pick the fields to appear in the report.  ACE will format 
                                          the fields based on the type and size, and any formatting that you supplied 

                                          when you set up the database.   
 

Column Justification: Select Left (Default), Right, or Centered. 

 
Column Fields: This box shows which fields have been added to the current column.   
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3. Each report must have at least one column, so ACE automatically creates the first column. After  
   adding your fields to the first column, you can either Add a new column after the current column, or 

   Insert a column before the current column by using the buttons on the toolbar.    
 

 
 

After either creating a report or adding a new column, you need to add fields to the columns.   

 
To add fields to a column:  

 

1. Scroll through the ACE Available Fields list to find the field that you want to insert.   
    Some special fields have been created to make it easier to enter the contact name and address.  

    These are the first fields listed in the list;  
 

Primary and Secondary Contact: -           Inserts the Salutation, First, Middle, and Last names. 

Primary and Secondary Address: -           Inserts the Street 1 and Street 2 Fields.   
Primary and Secondary C, S, and Z: -      Inserts the City, State, and Zip codes.  

  
2. Select the field to enter by double-clicking it, or by highlighting it and hitting [ENTER].   
 

     Note: The name of the first field you select will appear as the Column Heading. You can change the  
                Column Heading by selecting that box, deleting the text that is there, and typing your own 

                 heading.   
 
3. Continue selecting and adding fields for this column until you have added everything you want for  

    this column.  
  

     Note: Don't try to put everything in one column. Think about the layout of the report and how you  
               want the report to look before setting it up.   
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4. When the column is finished, do one of the following:  
 

Click Add to add a new column after this column. 
                                 -Or- 
Click Insert to add a new column before this column. 

                                 -Or- 
Click Close to save the report and view it.   

  
 

5.28.0. Query Field Wizard 

 

 
 

To query one field: 

 
1. Click on the field to query with the right mouse button. The short-cut menu appears.   
 

2. Select Query Field. The Query Field Wizard appears.  The format defaults to Equal To, and the value 
     is filled with the contents of the current field. 

 
3. Search in the field by selecting the appropriate Format, and entering the value.  The list of formats is  
    shown below: 

 

Format: Value 

 
Equal To: Enter the value to search for.  Searches from the beginning of the field. 
Not Equal To: Enter the value to exclude.  Searches from the beginning of the field. 

Greater Than or Equal To: Enter the low value. Finds that value, and anything greater than the 
                                            entered value. 

Less Than or Equal To: Enter the high value. Finds that value and anything less than the entered  
                                       value. 
Between: Enter the Low value in the Min box and the high value in the Max box 

Empty or 0: No value (value is 0) 
Not Empty No value: (value is anything) 

List of Items: Enter a list of items to search for, one on each line 
Contains: Enter the value to search for, anywhere in the field. 
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4. Select Search to start the query. -Or-Select Add to search in another field.   
 

5. When a query is already set, you can further narrow the search by selecting Query Current Group .  

    ACE 7.1.0 will search for records that match the query.  When the query is finished, the records 
   display on the status bar will display the number of records in the current subgroup.  The message "No 

   records match query" will appear if ACE 7.1.0 doesn't find any matches.  In this case, the scope is  
   returned to "All Records". 

   
6. When you have finished using the query, select every record from the Lookup menu to return the  
     scope to all records. When a query is active, the Query On symbol appears next to the contact name 

     on the contact screen.  Release the query by selecting Every Record from the Lookup menu or by  
     double-clicking the Query On symbol.   

 
Note: The Added and Updated fields cannot be formatted or dialed.  When you right-click on these 
           fields, the short-cut menu does not appear, but the Query Field dialog box appears for use  

           on that field.  
 

 

 

5.29.0. Contact Image 

 

 Ace provides the users to upload images to the contacts. Go to the particular contact where you want to   

  include contact image. 
 
 

 
 
 

Click on the picture box provided to right of the contact details, a dialog appears here you can browse 
 and find the respective image you intend to upload. 
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Ace supports three image formats 

   .jpg/.jpeg 
   .gif 

   .png                
 
 

  
 
Click on the boundary of the image box for bigger contact image. 

 
 

 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

94 

 
 

5.30.0. Synchronization with Outlook: 

 

Users can synchronize Ace to Outlook. By synchronizing with Outlook users get contacts and events 

that are not present in Ace and vice versa. 
 

1. Click file from menu bar, select Synchronize with outlook. 
 

 
 

 
2. Make sure outlook is installed properly. 
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3. Provide necessary permissions when requested for synchronization. 

 
 

 
 

4. Wait till the synchronization completes. 

 

 
 

 
 

5.30.0. Synchronization with Mobile: 

 

Synchronization with Mobile allows Ace users to synchronize their Mobile phones to Ace. 

Components and software‟s necessary for Synchronization with Mobile 
 Microsoft Outlook. 

 Nokia PC Suite. 
 Mobile to PC connecting device (Data Cable). 

 

1. Make sure the mobile phone is connected to PC through data cable before synchronizing. 
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2. Click on file in menu bar, select Synchronize with Mobile. 

 

 
 

 
 

3. Nokia PC suite starts, that has been installed in your PC. 
 

 
 

 
4. Select your device in PC suite and click Synchronize in PC suite. 
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5. Wait for the Synchronization to complete, provide permissions when prompted. 
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6. If your device is not connected to PC, Nokia PC Suite indicates you have not connected. 

 

 
 

 
Note: Synchronization with Mobile requires Outlook; make sure outlook is installed before you 

          Synchronize. 
 
 

5.31.0. Survey  
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Survey tool can be utilized for people in marketing, sales, etc for surveying their customers or clients 

about the products, or customer satisfaction about their products, feedbacks. 
 

 
 

Ace users can manually add remove questions from the existing questions by selecting modify questions 

below the checkboxes. 
 

 
 

6.0.0. Contents 

 

6.1.1. Contact Screen: It is the Main Operation screen. Here we enter the Contacts, schedule our  
                                      Appointments and send Mailings. 
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6.1.2. File Menu: Create and access new databases, Setup and maintain your databases, Synchronization  
                              with Outlook and Mobile. 
 

 
 

                                        

6.1.3. Edit Menu: Edit Contact records and memos, database moves and view group fields. 
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6.1.4. Schedule Menu:  Adds Events to your Calendar and Schedule. 
 

 
 

  

6.1.5. Lookup menu:  Lookup contacts by one of many indexes, and Query by Example. 
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

102 

 
                                          

 

 

 

 

6.1.6. View Menu:  View Contacts, Events, History Records and other screens. 
                              

 
                                          

6.1.7. Call Menu:  Dial up Contacts fast with Speed dial or log your phone calls. 
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6.1.8. Tools Menu:  Use the Calendar or Task Manager to plan your day. 
 

 
                                          

 
6.1.9. Write Menu: Print letters envelops and labels. 

 
 

 
                                                                                                                                                    

6.1.10. Reports Menu:  Print Reports and Contact lists. 
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6.1.11. Windows:   Arranging icons and selecting the form layout design. 
 

 
 

 

 

6.1.12. Help Menu:   Provides guidance on how to use the ACE Contact Manager Help system.  
 

 
  

 

 
7.0.0. ACE Kick Start 
 

To help you become familiar with ACE, this "Kick Start" section takes you through a hands-on tutorial 
of the basic features. Before you follow this "Kick Start", you should have already installed ACE. If you 

have not installed ACE, then return to ACE Installation. If ACE is already installed, then bring up ACE 
by clicking on the ACE icon. 
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The above screen should be the first you see. If the Initials are not correct, you can {Shift} {Tab} to 

return to the initials field and fill in your correct initials. Then using the {Tab} or {Enter} you arrive at 
the Password field. Here you entered your password. This password was either assigned by the ACE 
administrator or is the one you assigned yourself when you first entered ACE. Next, you see the screen 

below unless ACE has already been registered.  
 

If you want to register at this time, then go to Trial Version Display to learn how to register.                               

 
 

7.1.0. Kick Start - Adding a Contact 

 

Once past the trial version window, you see the prompt. Choose No to "Show Time Management Form”. 
Now you have the "Contacts" window as shown below. 
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The first thing you want to do is add a contact to the ACE Demo database. Once you add the contact 

described here in the "Kick Start", you can then add yourself to the database. 
 

7.1.1. To add a contact: 

 
1. Select the Edit menu. The word Edit is located at the top of the ACE Client Window.  

This is called the Menu Bar. You can select the Edit menu in two different ways. Press 
{Alt} E or use the mouse pointer and left mouse button to click on the word Edit. 

 
                                              

2. Select the Add option. Press A or click on the Add button using the mouse. The contact   
    Information Window will appear. 
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 This window holds the name and address information of your contacts. Type in the requested 

information in each field. Press the {Tab} key to go forward to the next field or the {Shift} 
{Tab} key to go backwards to the previous field. Click on Save or press the {Alt} S key only 

when you are ready to save your information. In the following example we will add Peggy 

Gorney of Life Line to our database. 

 

 You start at the Sal (Salutation) field. Type in: Ms. optionally you can click on the drop down 
   menu icon to display ACE's powerful drop down menus. Choose a salutation of Ms. Now type a 

  {Tab} key to move to the next field. 
 

 
 

  Enter the First (First Name) field. Type in the first name: Peggy {Tab}. Notice the Capital P   

             was automatically formed without you having to enter a {Shift} key. 
 

  We do not know her middle name so just press {Tab}. 
 

  Type in her last name: Gorney {Tab}. 
 

  You are now at the Dear field where "Ms. Gorney" is displayed. If you wish to change it now  
    do so, otherwise key a {Tab}. 

 

 You should now be in the Title field. Peggy is the Assistant Manager for her company. This is a   

   Good spot to discuss more fully the powerful ACE Popup tables. Most of the Field Titles here  
   will bring up a Popup table for you if you double click on the Title.  

                                                                                                                     These tables can be edited by  

             you to have all the answers you wish for each field. Using the mouse point, double click one the  
             word Title using the left mouse button or press {Shift} {Enter}. A table of common entries for 

             this field appears 
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   Select the Assistant Manager entry, and then select Paste which is the icon at the top, or just key 
     {Enter}. 

       
      HINT: Use the thumb and scroll bars to scroll up and down the Popup table list. Press 

                   the {Tab} to move to the next field. 
 

   The cursor should be in the Company Field. Type: Life Line {Tab}. 

 

   The cursor should be in the Street1 Field. Type in the address of Peggy: 11265 via Pacifica 

     {Tab}. 
 

  The cursor should be in the Street2 Field. Type in the suite number: Suite 1C.Then press {Tab}.   
         

 
          

   Surprise! The cursor jumps to the Zip Field. Enter Peggy's zip: 91719. Then click on Zip Lookup 

     or press {Alt}. 
 

   The City and State fields are correctly populated for you with Corona and CA. 
 

 The cursor should be in the Country Field. There is a drop down menu here. You can also just 
            Start typing and the nation will be filled in for you. Thus press U and the rest of USA will be 

            entered for you. Then press {Tab}. 
 

 The cursor should be in the Department Field. Peggy does not belong to a Department. Press  

            {Tab}. 
 

 The cursor should be in the Email-ID Field. Peggy gave you her email address so enter here:  
       Peggy@lifeline.com . Press {Tab}. 

 

 The cursor should be in the Webpage Field. Enter Peggy's company's web page:  

       www.lifeline.biz . Press {Tab}. 

mailto:Peggy@lifeline.com
http://www.lifeline.biz/
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 .  The cursor should be on the Work Field in the Phone Numbers section. Enter Peggy‟s phone  
            Number: 940.555.1212. Notice the periods are inserted automatically for you. This helps force 

            a particular entry style. 
 

 The cursor should be on the FAX Field. Peggy did not give you a FAX number so press {Tab}. 
 

    The cursor should be on the Home Field. Again press {Tab} because you do not have this 
       information. 
 

   The cursor should be on the Other Field. Peggy gave you her cell phone number, enter it here:  
     940-333-1212. Press {Tab}. 

 

   Your attention should be on the "Hot Contacts" button. If for now Peggy is on your list for 

      keeping up with her at the top of your list, then click on the check box here and the check will 
      appear. This flags for ACE that this contact is "Hot". 

 

 Your attention should be on the "Phone Book" button. If you wish to automatically add Peggy to  

       your Phone/Email book, click here. 
 

   Finally, click on Save (or Press {Alt} S) to enter Peggy into the ACE database. You have just 

     added your first record into ACE. Now add yourself by adding a new contact record and then  
     following steps 1 through 21 replace Peggy's information with your own. 

 
NOTE: As you move the mouse over the ACE screen, the bottom of the screen has a status bar. This bar 
              is an instant help system that follows the mouse and tells you what the current section of the 

              screen does in which the mouse pointer is moving. 
  

7.2.0. Kick Start - Changing Field Titles 

 
The ACE contact screen contains 3 sections of User Definable Fields plus Groups. A field is an area that 

holds information. Many fields compose a record. A record is what we just added. 
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The Fields outlined above are all user defined fields. ACE allows you to change the User Defined 

Fields. In all, there over fifty fields that can be changed. These are in addition to the 22 Groups that may 
be changed. See Group for more information concerning Groups.  
 

As mentioned and shown above, there are at least three different sections of User Definable Fields. For 
example, the four phone number fields are a section; the middle portion of the contact screen contains a 

section, and the Logical Fields in the left hand side portion of the contact screen are the last section to be 
discussed here.  
 

Any User Definable field can be changed by right clicking on the field name and having permission to 
change the field. 

 
 

 

 

 

 

 

 

 

 

 

 

 

7.2.1. Change field name 

 

  Select View from the Menu Bar by pressing {Alt} V, and then select Other Screen by pressing   
 O. The middle section of User Definable fields should change. 

 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

111 

  Move the mouse to the filed called User 17. Press the right mouse button. A new window pops 

 up with a listing of all User Definable fields. The field you selected, User17, is currently  
 highlighted. To the right of the field, there are information boxes. See below: 

 

 
 
 

  The cursor is in the field Label. Delete the existing characters by pressing the {Delete} key. If 
    you clicked on the field once you were there, you can use the {Backspace}  key then to erase the 

    field. We will call this field Hobbies, so type Hobbies.  
 

    Ignore the other information in this window for now like –  
    Color,  
    Format,  

    Tab Stop,  
    Visible,  

    Example View,  
    Field name,  
    Type, Length and, 

    Decimals. 
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  Click on the button close. 
 

7.3.0. Kick Start - Editing a Contact Record 

 
In the previous topic, "Kick Start - Changing Field Title", you changed a user definable field. Now let us 

fill in some information. First we will need to find the contact record for Peggy again. To find the 
contact record for Peggy Gorney: 

                                                                                                                                  
1. Press {Alt} L or click on Lookup. You should see the following popup; 
 

2. Select Last Name by pressing L. 
 

3. Type: Gorney and press {Enter}. 
 

 
 

You are now at Peggy's contact record. Notice that we typed Gorney in lowercase letter, but ACE still 
found here. To edit any information on the screen, just click with the mouse on the field you wish to 
edit. Of course, you have to have permission to edit the fields. With the keyboard press the {Tab} key 

and/or {Shift} {Tab} (for moving backwards) until the cursor appears in the field you desire to edit. 
 

7.3.1. Edit a Field 

 

 Click on View from the Menu Bar or press {Alt} V, then select Other Screen by pressing O if 

the User field Hobbies is not displayed. Notice that this is a toggle switch and those three 
different sets of user fields are displayed in this user area. To return to a screen you must repeat 

the above sequence twice. This is also available by clicking the icon.         
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    Now repeat the above sequence until the Category field is shown. Double click the left 

mouse button on the work Category to access the Popup table or use the {Tab}  key to move 
to the Category data field and then press {Shift} {Enter}. Once on the Category data field 

you can click on the down arrow in the field and the Popup table will also appear. Select 
Political from the menu by clicking once on the word Political with the mouse. If you prefer 

to use the keyboard the letter P selects Political as shown by the Key column on the Popup 

table. Now select the paste Icon    or use the {Enter} key to paste. With the paste, the 
word Political is written to the category field. 

 

    Press the {Tab} key to move to the next field. Peggy‟s secretary is Delyla. Type Delyla. 

 

    Press the {Tab} key to move to the Business field. Again we can access the Popup table by 

double clicking on the word Business or by pressing {Shift} {Enter}. Once the Popup table is 
up, select Medical from the table, and then select paste by pressing {Enter} or clicking on the 
paste Icon. 

  

    She heard about our company through the Fall 94 Seminar. Move to the referral field with a 

{Tab} and access the Popup Table again by double clicking on the word Referral or press 
{Shift} {Enter}. Select fall '94 Seminar. 

 

    We forgot to type in the phone numbers for Life Force. Click on the Work Phone filed and  
                type 9095551234. Press {Tab}. Type the Fax number 9095551233. Press {Tab}. 

    We are finished with this contact record for now. Click on the icon  or press {Ctrl} S to 
save the data we have changed. 

 
  

7.3.2. Undo Contact Edits 

          
With this feature, you can undo the edits to your contact record. 

 

 

7.3.3. Copy contact to Clipboard 

         
You can copy the contact record to clipboard and you can paste it where ever you want. 

 

 

7.3.4. Global Replace 

 

Use Global Replace to clear out a field, to replace a field with another field, to move data from one field 

to another, to replace a field with one value, or to remove/replace characters from a field.   
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

114 

 
 

 

 

 

7.4.0. Kick Start - Adding a Memo 

  

The memo field is one of the most used features of ACE. By presenting the memo field as part of the 
contact screen, you will never forget the important notes about each client. The memo field is shown in 
green border below: 

 

 
 

1. You can add a memo by clicking on the memo field with the mouse or by selecting  
             Edit Memos. 
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2. You can also select the memo field with {Ctrl} +M. If the memo box is accessed through the  

     Edit menu, the Hot Keys or by double clicking the mouse in the memo field, ACE will 
     automatically Date and Time stamp the memo box with the current date and time and enlarge  

     the memo. If you single click on the memo box with the mouse, no Date and Time stamp is  
     added and the memo field is not enlarged. Let us add a memo: 
 

 

7.4.1. Add a memo 

 

  Press {Ctrl} +M. 

 

  Type: I spoke with Peggy today. She really likes the demo and said shall call back 

                       tomorrow with an order. 
                                                                                                                                                    

  Click on the Save button or press {Alt} S to save the memo. The popup screen disappears when 

you save, and the data appears in the memo field. 
 

 
 

7.5.0. Kick Start - Looking up Contacts 

 
There are two ways to look up contacts using ACE -- Lookup and Query by Example. The quickest and 

most convenient is the Lookup command. 
 

The Lookup menu item commands instantly access a specific contact. There are eleven default lookup 

configurations. There are five lookup configurations which are user definable. In this users guide, if you 
have followed it from the beginning we have already looked up „Peggy Gorney‟ using the Last Name 

Lookup command. Right now we will lookup contacts using a few of the Lookup configurations. 
 

NOTE: When you use the Lookup command, your contact database view is immediately sorted by the  

              way you lookup. For example, assume you look up Peggy Gorney by her last name. Your view 
              of the contact database is immediately set to Last Name sort order. First, let us look up a contact  

              by its company name. 
  

7.5.1. Find a contact by company name 

 

  Select the Lookup menu option by press the {Alt} L or click on the menu item Lookup. Notices 

    when you press the {ALT} key, the underlines appear to assist you in selecting the correct menu  
    item. 

 

  Select Company by pressing C. 

 

  Type: Three {Enter}. 
 

Jack Tripper of Three Company should now be the current record. If you browse through your database, 
you will find that all of the contacts are now sorted alphabetically by the company name. 
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7.6.0. Kick Start - Looking up Contacts – Browsing 

 

To browse through the database, you can use the {Page Up} and the {Page Down} keys or click the 
mouse on the standard four icons shown below. 

 

                                         
 

These are the Previous (left point arrow) and Next (right pointing arrow) icons with the database begin 

and database end icons surrounding them. {Page Down} or the right arrow move you one contact 
forward. {Page Up} or the left arrow moves you one contact backwards.  
 

If you have a special need to instantly Lookup clients by a field other than Company, Last Name, First 
Name, or Phone, (such as email address) ACE has User Defined Lookup commands to accommodate 

you. You can change these User Defined Lookup commands. We won‟t change any right now, but we 
will use an existing user defined lookup, the Category field. 
 

 
7.6.1. Find a Contact using Lookup 

 

  Select the Lookup Menu option by pressing {Alt} L or by clicking on the word Lookup. 

 

  Select 2 Categories. 

 

  Type in a category for which to search. Type: Medical {Enter}. 
 

You should now be at Peggy Gorney's record if you are following the user‟s guide in order and Peggy 
has been entered into your database. 

 
7.7.0. Kick Start - Looking up Contacts - List Records 

 

Let us now browse through the database again, this time using the List Records Command. From the 
menu you can click on View then click on List Records. From the keyboard you can use {F5} or you 

can click on the icon   . 

 

 

7.7.1. Find a Contact Using List Records 

 

  Lookup the ACE contact here on the List of Database Record by searching in the Company field 

and entering in the search window ACE. 
 

 The records in your view of the database should show the following screen: 
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The ACE record is highlighted. You can use the {up Arrow} and {Down Arrow} keys to move through 
the list. You can also use the mouse to move the scroll bar on the right. To select a specific record which 

is highlighted, press {Enter} or double click on a record. 
 
To list your contacts 

Select List records from the View menu.  
The current subgroup or entire database will be listed, starting with the current record.  Scroll through 

the list to move to the record of your choice.  
  
To move to a specific contact record 

 Highlight the record to move to.   

 Select Close.  

 The list window will close and the highlighted contact record will appear.   

 Select Cancel to return to the contact record from which you accessed the list.  

  
To delete a record in list view 

 Highlight the record to delete. 

 Select Delete. The Record Delete Options window appears. 

 Select Current Record only to delete only the highlighted record. Current Group to delete the 
current group of records and Entire Database to delete the entire database.   

 Select OK. The record is removed from the database.   
 

To calculate the sum or average of an ACE field 

 Select the math button on the list toolbar. The Calculations window appears with the numeric 

fields listed. 

 Select a field to perform the calculations on. 

 Select Sum to receive a total of that field for the entire database or subgroup. 

 Select Average to receive the average for the field.  (Total / number of records in scope) 

 Select Close to return to the list. 
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 Use the windows copy command to copy the value in the sum or average box. Simply drag your 

mouse cursor over the value, and type CTRL+C.  Then use the windows paste command, 
CTRL+P to place the number in a field in your database. 

 
To view each record as you scroll through the list 

Select the Sync button.  If you are searching for a record, it is faster to work with the Sync option turned 
off. 
  

To create a new field list 

 Select the new list button on the list toolbar. 

 The User Defined Lists window appears.   

 Select Add. A new window appears with a list of your database fields.   

 Select the fields to place on the list by highlighting the field name and selecting Add.  If 
you change your mind, highlight the field to remove and select Delete.  An extra field, 

called Contact, is provided to add the Last, First name combination in one column of 
your list.  You may add as many Fields as you like to the list; however, the screen can 

only display approximately five or six fields at once.     

 Name the list by typing a name in the List Title box.   

 Select Edit Column to change the column heading of the field in the list. (For example, 
change a field named Ser. # to appear as Serial Number in the list)  Select Save to save 
the changes to the column heading. 

 When all fields are selected, save your list.   
 

To use the new list 

 

 Highlight the list to use. 

 Select Use. Select Edit to modify an existing field list. Make the desired changes and 

save the new list. Select Delete to delete an existing field list.  You will be asked to 
confirm deletion of the list before it is removed.  

  
To Tag records 

   

 Click in the left-most column of the list. A red plus sign will appear in the column.  (+).  

 Continue tagging until all desired records are tagged.  

 Right-click in the list window to see the list options. The fly-out list menu appears. Select the 
item on the menu to the right for help with each item.    

 

 

7.8.0. Kick Start - Looking up Contacts – Query 

 
The query command lets you find and group contact records together. If you need to find contact records 

based on a field for which you have not pre established a Lookup index, then you can Query on it. The  
Query is probably the most powerful feature of ACE.  
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You can search your database and basically find any word, phrase or text that has been typed into a 

contact screen. The ACE Query system uses technology which greatly enhances the speed of Queries. 
You may be able to search a database of 30,000 records in less than 2 seconds.  

 
The ACE Query allows Boolean logic. You can specify greater than, less than, equal to, contains etc. 
You can also use „AND‟ and „OR‟ statements. For instance you can find all contacts that live in CA or 

NY and purchased a green widget. For our sample database we will create a simple query to find all 
contacts which live in CA or NY and are considered Prospects. 

 
 

7.8.1. Query for Prospects Contacts in CA or NY 

 

  

  Select Query by Example from the Lookup Menu by pressing {Alt} L followed by Q. You can   

also press the Hot Key combination of {Ctrl} Q or click the query icon. . 
 

  The Quick Query Window is now on your screen as below : 
 

 
 

 

  Select the first field on which to query. Press the {Tab} key until the cursor rests on the State 
    field, or just click on the State field using the mouse. 

  

  Type in the states for which you wish to search. Since we are searching for either CA or NY, we 

     need to type both entries. Type: CA, NY.  
 

NOTE: When using the Query, all conditions are searched unless you type a comma in the field. When 
a comma is typed, ACE will search for either of the values separated by the comma. 
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 Now access the Prospect field. This field is a logical field. A logical field is either on or off, yes or 
no, true or false. You tell ACE to search on the field by clicking the box located immediately to the left 

of the field. When clicked, a check mark should appear in the box.  
                                                                                                         As you are creating the query, ACE 

automatically assumes an AND operator between each condition of the query. This means that only 
contacts that meet every condition of the query will be found. For detailed information about using AND 
and OR statements, see AND/OR (link) further in this guide. 

 

 You are now ready to use this query. You can either Save the query for future uses by             

selecting Save, or use the query only once by selecting Run. These buttons can be selected by {Alt} S 
or {Alt} R respectively. Select the Save button by using {Alt} S. 

 

  You will be asked to type in a description of the query as shown below. Type: State is CA or NY 
and Prospect {Enter}. ACE will save the query and immediately execute it. The saved query can later be 

accessed by using the Lookup menu  Saved Queries.  
                                                                                      ACE will immediately create a sub-group based on 

the query. If your query takes more than 1 second to create, a Status Meter pops up in the middle of the 
screen telling you the status of the search. Once completed, the status on the left, as shown below, 
reflects the total number of valid records matching the query. Also you can see that you have a subgroup 

and this group is in order by company. 
 

 

 
 
 

NOTE: Many times the ACE Query system can optimize the search of your data. This creates an instant 
              query. When this happens, the Status Meter will not pop up. Now that your query is complete 

              and has set up ACE for you, you can only view records that match your query.  
                                                                                                                                   
              Try browsing through some records using the methods discussed here. You will notice you can   

              only view a few clients in the small demo database. The rest of the clients are outside of your  
              query. To terminate the query, access the Lookup Menu and select Every Record. 

 
 

 

NOTE: You can create quick sub-groups by using the Lookup command instead of the Query. See the  
              discussion on Lookup later in this guide (link). 
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7.9.0. Kick Start - Scheduling Events 

 

Events are what ACE uses to help you keep track of information. ACE is centered on Events. With 
events you can schedule calls, appointments, meetings, to dos; follow ups, anniversaries, social events, 
personal events, travel plans, birthdays, and holidays. Keep track of Events will help you get through 

your day without forgetting or losing any information. If used correctly, your daily activities will flow 
more smoothly than ever before. Let us schedule some events for you and Peggy. First we need to look 

up your records. If you are working your way through this Kick Start and still have a Query set we also 
need to get rid of it. 
 

7.9.1. Let us look up your record: 
 

  In case your Query is still set, we will turn it off. Select Lookup by pressing {Alt} L. 
 

  Select Every Record. Your Query is now turned off. We need to look up your record. If you  
             have not entered into the ACE Demo Contact Database, then do so now.  

 

 To find your contact record, select Lookup. This is accomplished by pressing {Alt} L or by  
             clicking on the word Lookup. 

 

  Select Last Name. 

 

  Type your last name and press {Enter}.You should now be at your own Contact Record Screen.    

 We are going to schedule your Birthday. 
 

 

 

7.9.2. Schedule Timeless Events 

 

  Select Schedule by pressing {Alt} D or clicking on the word Schedule. 

 

  These events have Timeless checkbox disabled, indicating it is not a Timeless event. 
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 Some of the Timeless events in Ace are: 

1. Outlook Event 
2. Birthday 
3. Anniversary 

4. Holiday 
 

 Timeless events cannot be finished it can only be deleted. 
 
                                                                                                                                                                                         

7.9.3. To set up a Birthday 

 

 The Birthday icon is already selected. NOTE: If you want to change this from a Birthday to a 
different event, you can click on the down arrow at the end of the Event – Birthday sequence. 
This will pull down a menu of icons with descriptions. Double click on the event you wish to 

use. Alternately you can press {Alt} {Down Arrow}. This will also pull down a menu of icons. 
You can then use the {Up Arrow} and the {Down Arrow} keys to highlight the Birthday Cake 

icon line and press {Enter} to accept. 
 
 

 
 Press {Alt} D to access the Date section. Type in your date of birthday. Alternatively, you can 

also select the calendar icon to the right of the Date area. If you select this icon, you can scroll 
through the calendar to select the correct date. For detailed information see the topic on Events 
(link). 

 
 The Timeless field is checked, and the time fields are blocked out when we schedule Birthdays,     

so you can ignore this field. The regarding field is automatically filled in for you when you select 
a Birthday event. At this point you can type a memo if you wish. Just click on the open box area 
with the mouse or press {Tab} until the cursor appears in the memo typing area. 

 
 Let us press {Alt} S or click on Save to save the event. Your birthday should now appear in the 

events window on the contact screen. As mentioned earlier we are now going to schedule 
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probably the most important event, the Phone Call. Let us schedule the phone call for Peggy 

Gorney. First you need to find her in your Contact Database. Use the information already learned 
in this "Kick Start" section to Lookup Peggy's contact record. Once you have located Peggy: 

   
 

7.9.4. Schedule a Phone Call 

 

 Click on the Schedule menu item. Then click on Phone Call. Another method to achieve the 

same end result would be to use the Hot Key {F11}. This brings up the Schedule an Event window. 
 

  We want to schedule the call for later on today, so the default of today's date is fine in the Date 
field. We can therefore skip the Date field. 

 

   Press {Alt} T to access the Time field or click on the Clock Icon located next to the Time           
field. The Time field has two times. One for the Start time of the event and one for the Stop time. We 

are going to make a phone call that should not last over 15 minutes. 
 

   When you select your time you can manually type it in, by typing 04:00pm as the Start time. 
 

   You now need to select the Stop time. Press {Tab}, then {Shift} {Enter} or click on the second 
clock   icon. A list of times appears with the default time slots in five minute intervals. You can scroll up 

and down the times to select the appropriate time. The Start time is highlighted. Now select   04:15pm. 
                                                                                                                                                     

 
                                                             
 

   Your time range is selected. {Tab} down to the regarding field, or press {Alt} G. Type: She is 

Ready to Buy. 
 

   This is an important call, so let us set an alarm. Press {Alt} R or click on the Alarm box. A 
check mark should appear next to the word Alarm. 

 

    If you want to set a lead time for the alarm to go off before your actual appointment, then 

change the time in the alarm area. Enter the time, such as 3:55pm, or click on the clock next to 
the time field and choose 3:55pm. 
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   Since ACE is always network ready, select the Private Button to have this event only show up 

while you are logged in. 
 

  If you now need to add memos about this call, you can click on the large editing box or press 
{Alt} M. You can add pages and pages of memos, (for 16 bit version up to 64 K), to this call if 

you wish. Once you have clicked on the memo box, type: Persuade Peggy to sign the 

agreement. 

 

  Click on Save or press {Alt} S to save this event. 
 

The phone call should now appear in Peggy's Contact Screen in the event box area. Any events that you 
have scheduled for Peggy will appear in the same box. To see your whole schedule of calls and other 

events, you need to access the Time Management System. 
 
7.9.5. Sequenced Events 

 

Sequence EventsAuto SchedulerWith the Auto Scheduler property, you can Add, Delete Edit or 

Schedule an event with your own description. 
Use sequenced events when you have a series of events that you usually schedule all at once for the 
same contact. If you usually set an event to send out a letter to a new contact, then to call back in a 

week, and then follow up in a month, you can schedule all of these events with one mouse click 
 

 
 

  

 

 

 

          

 To Add, Edit and Delete an event in the sequence  
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7.10.0. Kick Start - Time Management Screen 

To see all of the scheduled events you have in the ACE system, select the Time Management icon . 

You can also use the Hot Key of {F2} or select the Views menu, then select Time Management. Once 
selected, the Time Management Window appears: 

 

 
 

This window shows all of your scheduled activities. By accessing this screen you can see what your 

daily events are supposed to be. You can select an event simply by double clicking on the appropriate 
item using the mouse. 
 

 

NOTE: Yes, this is the screen that asks you if you wish to see it when you first enter ACE. Under 

Preferences you could remove the requesting message if you desire. When you access an event through 
the Time Management Screen; ACE brings you to the contact that is attached to the event. Once you 
have accessed the Time Management Screen, you can go to any event by: 
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  Selecting the event to which you wish to go. You can do this by clicking on the event with the 

mouse or use the {Up Arrow} and the {Down Arrow} to arrive at the event. Double click on it to 
go to it. Or you can key {Enter} to go to the contact for which the event exists. 

 

7.11.0. Kick Start – History 

 
ACE maintains a History log for each contact database. Keeping track of what you have accomplished is 
often as important as keeping track of what you need to do. ACE isolates your historical record of events 

in a separate database associated with each contact database. The History database keeps records of 
events as you finish them and removes them from the Events database. The events database covers all 

databases in the organization. Each database has its own History. You also have the option of adding a 
History Log even if you did not set up an event with an ACE contact. 

 

7.11.1. Finishing an Event 

 

We will assume we have just called Peggy, and she agreed to the proposal. We want to log that 
information, and then remove the scheduled call. The way to do this is to convert Peggy's scheduled call 
from an Event to a History item. This is called "Finishing an Event." 

 
First we need to view Peggy's events. 

 

 1. Lookup Peggy's record. Her events appear in the Events Display area above the memo field. 

 

 2. With the mouse, click on the phone call listed for 4:00 today. The call becomes highlighted. 
 

 3. Again with your mouse, right click on the same event. A new Events Shortcut menu appears. 
 

 
 

 4. Select Finish from this menu with the mouse. A history Record appears with the event         

information filled in. 
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 5. Type: The deal is set into the memo field. 

 

 6. Select Save to convert the event to a history record. The event is removed from the general          

Scheduled Events file and added to the History Log for the database. Any event can be finished in 
this manner, but you do not have to convert an event to a history file. If you do not need to keep 
track of past events, you can simply delete them. 

 

7.11.2. Viewing the Contact History Log 

 
The Contact History log shows all activity with a contact. Calls made, meetings, letters, faxes, memos, 
and any other events that occur with the client are added to history when they are finished. When a 

contact record has an entry in the history log, the file cabinet on the left of the screen appears with the 

top drawer open . Clicking on the file cabinet brings up the history log. Likewise when a contact 

record has no entry in the history log, the file cabinet on the left of the screen appears with the top 

drawer closed . When you view the history file, only the current contact‟s history is displayed. You 
can, however, view all history for all clients. 

 
Let us view all our History items 

 1.Do one of the following : 
         a. Click the History Icon on the Status Bar. 

         b. Select History from the View menu. 
         c. Type the shortcut key {F4}. 
                                                                                                                                                   

 2. Click the Unlock icon () to view all of the History entries . 
 

 3. Click Close () to close the History window   . 
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7.11.3. Timezone 

 

The ACE 7.1.0 Time zone lets you edit and update the current contact Time Zone settings. As shown in 
the picture below, you need to edit the time zone settings and click on the OK button to update the 
changes 

     

 
 

 

7.11.4. Contact Attachments 

 

The Ace Contact Attachments meets the need of an organization by adding the any files to it and allows 
viewing those files.   

                                   

 

 
 

 

 

7.11.5. Database links 
 

The shortcut key for Database Links is SHIFT+F3.   

Use the Link function to link one contact record to others in the database. View the records along with 
their relationship. 
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7.11.6. Pending Alarms 

 

Displays the alarms which are pending for the related events. 
 

 
 

7.11.7. Past due Alarms 

 

Displays the alarms that are past due for the related events. 
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7.12.0.Kick Start - Task Manager 

 

Ace Contact Manager has many tools, including several views of the calendar, a Task manager, To-do 

list and a paper file index (PFI). These tools can be used to execute a productive day in a style to which 
you are accustomed. 

 

 

7.12.1. Task Manager 

 
Many people use the Task Manager to keep track of the tasks which they have assigned to other 
employees. In general, the Task Manager offers a way to track general To-Dos, chores, group projects 

and employee tasks. As an example, we will add a task to assist us in tracking a newsletter. 
 

To Access the Task Manager do one of the following: 

a. Click the Task Manager Icon on the main toolbar  . 

 
b. Select Task Manager from the Tools menu. 

 

c. Type the shortcut key {Ctrl} {F3}. The Task Manager appears. 
 

Select the Add icon ( ) or go to the Edit menu item and then select Add. 

 
1. Type: Finish Newsletter/Send to Contacts  on the Task line. This is similar to the “Regarding” 

input box of an event. 
 

2. Click on the Priority field or press the {Tab} key. The priority field is a number which you 
assign to gauge the importance of each task. The default value is 1. We will assign this a priority 
of 2. Click the up arrow in the Priority box or type the number 2. {Tab} to the Data Due field. 

 

3. The next field is the Data Due. Use the date finder (  ) to set a date two months from today's 

date. 
 

4. Click the date finder icon next to the date to display the Date Finder. A small calendar appears 

with today's date highlighted. 
 

5. Click the Next Month icon ( ) twice to move two months ahead. 
                                                                                                                                              

6. Click the Paste icon ( ) to place the highlighted data into the Data Due field. {Tab} to the 

Status field. 
 

7. The Status field is for your use. Use it to record your progress on the task. The default status is 
„Pending’. Since we are finishing up a newsletter, we can leave Pending in the status filed. 

{Tab} to the Who field. 
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8. The Who field is used to assign tasks to individuals or departments. Since this is your task, your 
initials appear in the Who field. 

 
9. Each task has an open memo field for typing notes. Click on the memo field and type: Gather 

necessary materials and articles from current contacts. 

 
10. The task is still in progress, so leave the Finished box blank for now. It will be used later when 

the task is completed. When you do click on the Finished box, the data is recorded and the Task 
is recorded as finished in the Status Box. 

 

11. Click on Save or press {Alt} S to save. 
 

12. The Task Manager window appears with your new task displayed. Form this window you can 
view, edit, finish or add additional tasks. Select Close to close the Task Manager. 

 

 

 

 

7.13.0. Kick Start – Write 

 

Under the Write menu on the main ACE window, you can create written communications. Ace supports 
email, fax and paper documents. From the Write menu you can perform a broadcast E-mail, launch a 

single E-mail, create form letters, write a Quick Email, Quick Letter, Quick Memo, or create a Quick 

Fax cover sheet, edit your word processing Original Templates, access Win fax Pro for single or group 
faxing and print Envelopes and Labels. 

 
The Write menu is as follows: 
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7.13.1. Word Processor - Microsoft Word 

 

ACE interfaces with the Microsoft Word product as its word processor. When you use the Write option 

to create documents, ACE will load your licensed copy of Microsoft Word. Currently this is your only 
choice under the Preferences section in the Edit menu on the Main ACE window. If you have a strong 
need to support a different word processor, please contact ACE at www.GoAce.com for details. 

 
 

 
 

 

7.13.2. E-Mail and Web Access 

 
Ace supports sending E-Mail, sending broadcast E-Mail (E-Mail Merge), receiving E-Mail, personalized 

E-Mail, multiple E-Mail accounts, logging E-Mail to a record's history file and launching your web 
browser. You can also have ACE link to Microsoft's Outlook. ACE assumes you currently have internet 
access and are using some email client and some web browser. If you are not this far, you should contact 

an Internet Service Provider to get this far. Broadband connection (DSL, cable, or satellite) is the most 
effective way to access the web. 

 
Note: It is possible to send E-Mail only if the contact has a valid E-Mail ID. 
 

 
7.13.3. FAX Interface 

 
ACE supports single or group faxing using Win fax Pro under this Write menu, the Win fax Pro Links 
will load Win fax Pro versions 4.0 and higher. ACE exports the current record's Name and Fax number 

information into Win fax Pro's address book and then into the cover sheet. When accessed, ACE will ask 
the user whether the user wishes to create a historical record of the correspondence. This will place a 

copy of the fax in the current contact's (or each contact of the group's) history file. 
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The Regarding and Memos items on the "Historical Correspondence Information" form are used for 

creating the fax cover sheet. The Regarding text becomes the Subject section of the fax cover page. The 
Memo section is used to create the fax cover sheet's text section. After you complete the Historical 

Correspondence screen, you will go to the Win fax Pro screen. The „To’ section will be completed with 
the data from the current record's salutation, first name and last name fields. The Number section of the 
Win fax Pro screen will have the data from ACE current record FAX number. From this Win fax Pro 

page you can also attach files to the cover page. For a group fax, the Recipient list contains the contact 
list you created. Win fax Pro then uses this list. 

 

 

 

Sending a FAX through the Win fax Pro link 

 

  Click on the Write menu option. 
       

  Select the Win fax Pro Link (Single Record) or Win fax Pro Link (Current Group) item. The 
Single Record option will export information for one cover sheet from the current contact. The 

Current Group option will export the current group of records to the Win fax address book. If 
there is no query set ACE will export information for every record in the database. 

 

  Complete the Historical Correspondence Information as discussed above and click on the 
Continue   button. Next, Win fax Pro processes this information as you instruct.  

 
HINT: See the Preferences menu item under Edit to determine which preferences for communication 
ACE is using. 

 

7.13.4. Paper Documents 

 
The Write menu allows you to utilize Form Letters. When you first create a form letter using ACE, the 
name and address merge fields are inserted into your letter. When you click on the Write menu item 

then in the Form Letters sub item you see the following: 
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This screen allows you to browse your form letters, add form letters(Alt+A), edit form letters(Alt+E), 
delete form letters(Alt+D), copy form letters(Alt+O), access letter details(Alt+T), and query for 

letters(Alt+Q), pick merge fields(Alt+F), print a letter(F9), and do a mail merge with your 
letters(Alt+M). These functions are discussed in detail elsewhere. The Write menu also allows you to 
print labels and envelopes. The "Envelopes and Labels" screen as shown below is discussed elsewhere. 

 

 
                             

7.13.5. Quick Email, Quick Letter, Quick Memo and Quick Fax 

 

Ace provides you with a means of quick communications for correspondence. The Quick Email option 
shows you an Email form with the To addressee complete for the current contact. You can quickly select 
other contacts to receive the email as addressee, CC or Bcc recipients.  

 
The Quick Letter option produces a letter with no text that is ready to be typed and printed. The current 

record's name and address will be filled in for you along with today's data and your signature block. 
Changes will not be saved.  
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The Quick Memo option is useful for interoffice memos, notes or any other type of informal 
information which you wish to give to a contact. When you create Quick Memo using ACE today's date, 

the name of the current client record and your signature is automatically inserted into a document which 
is labeled Memorandum. The Quick Fax creates a fax cover page for you. The fax cover page will 
contain today's date and time, the contact to whom you are faxing, your contacts fax number, and your 

name in the „From’ box. There is also a space for you to insert your own fax number and a message on 
the cover sheet. 

 
 

 

7.14.0. Kick Start – Calls 

 

ACE has a built in auto-dialer which dials your contact's phone number if your computer modem is 
attached to a phone line and you have a telephone also on that line. ACE will automatically dial your 
calls and keep track of the time spent on the call automatically. Otherwise, you dial your numbers and 

start the timer yourself. The Call menu item on the main tool bar brings up the following: 
 

 
 

7.14.1. Auto Dialing 

 

Auto Dialing is one convenient feature of ACE. On the Call menu, the first three submenu items apply 
to the Auto Dialing features. 

 

7.14.2. Speed Dial 

 

Speed Dial will automatically insert the telephone number of the current contact into the Ace Quick 
Dialer so that all you have to do is click on Dial. All the other parameters for Speed Dial are set under 

Modem Preferences. 
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7.14.3. List Numbers 

 

List Numbers picks up all the numbers on the current contact and give you a choice of numbers to auto 
dial. 

 
7.14.4. Phone Call List 

 

Phone Call List presents you with the list of all the events for which phone calls are scheduled and not 
yet finished. Double clicking on one of these events automatically dials the contact number for you 
associated with the event. 
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The last item on the Call menu brings up the ACE Preferences for setting up the modem. We can also 

browse through Preferences under Edit menu to reach this window. As you can see below the Modem 
choices enable you to have good control over the modem on a telephone line. The TAPI features are 

available as an option. Connection through digital interfaces will be available in the future. 
                                                                                                                                                                                                                               

 
 
 

7.14.5. History Record Creation 

 

The next three items on the call list allow you to enter into the history records for the contact, the results 
of your call. Completed Call, Attempted Call and Received Call all bring up a History record to be 
completed with as much information already completed for you as possible. For instance, we will record 

a completed call that was made away from the computer, but needs to be recorded. 
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To record a completed call: 

 

1. First, find the contact you are about to call. Use the Lookup command to find Vicki Jones of 

     Marketing for Money. 
 
2. Select Completed Call from the Call menu. 

 
3. A History Record appears. The Regarding line reads "Completed Call", the Start and End times  

     read the current time. 
 
4. Because you made the call away from the computer, the time should be changed to Timeless.           

 
5. In the Memo field, enter the topic or results of the call. Type the following: Discussed plans for 

    next meeting. 
 
6. Select Save to record the completed call. The call is added to the History log for this client. 

 

7.14.6. Activate Timer: 

 

The Timer menu option brings up the automatic timer to help you keep track of time with the contact on 
the call. This is accomplished automatically with the Auto Dialer, but manually you can accomplish the 

same thing by filling out the result of the call and clicking OK. You can build a popup table of call 
results so that you need not always enter the same data. Notice that this timer stays as the top screen. 

 
 

 
 

                                                                                                                                                            

7.14.7. Modem Preferences 

 
For convenience, a Setup Modem menu option allows you to directly go to the ACE Preferences Menu 

Tab 3 Modem for modification of your modem settings. This is mainly for auto dialer users. 
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7.15.0. Kick Start – Reports 

 
ACE has many built in reports. These reports can be accessed from the Report menu on the main 
Contact menu. For this quick start demo, we will print two reports –1) A listing of contacts and 2) All of 

the scheduled events we have entered. When you print contact reports, the current contact database will 
print. If you have a query set, all the contacts in the query will be printed. 

 
7.15.1. To print a contact list 

 

1. Select Contact List from the Report menu. 
 

2. The ACE Printouts box as shown below appears. The Printout Type is set to Contact list. 
 
3. Under Paper Forms, Paper Sizes select 8.5 x 11 (Portrait). 

 
4. Select Options. The List Print Options window appears. 

 
5. Select No Memos to print only the field information for the contacts. 
 

6. Select Save to save the List Print Options. 
  

7. Select the print icon to begin printing . 
                                                                                                                                                     
8. A dialog box displays the status of the current print job. You can cancel this print job by 

clicking on the Cancel button on the dialog box. 
 

 
9. After ACE prints the list, the Ace Printouts screen reappears. Select close to return to the      
   Contact record screen. 
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The other report we will print is your calendar of events. We have already scheduled a few events plus 
ACE has many events build in such as Holidays and sample events. When you print calendar reports 

with ACE, you can choose from a variety of print layouts and paper sizes. 
 

7.15.2. To print the Weekly Calendar: 

 
1. Select Weekly Calendar from the Report menu. 

 
2. The ACE Printouts box appears. The Weekly Calendar is highlighted under Printout type. 
 

3. Under Paper Size, select 8.5 x 11 (Portrait). 
 

4. Selection Options: The Weekly Calendar Options window (shown below) appears. The Start 
    Date appears with the beginning of this week, and the number of weeks to print is listed as 
   (1)You may optionally choose to include memos and/or Tasks. You can select Event Types to be 

    included on the calendar. 
 
5. Select Save to save the Weekly Calendar Options. 

 

6. Select the print icon to begin printing . 
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7. A dialog box displays the status of the current print job. You can cancel this job by clicking on 

the Cancel button. 
 

8. After ACE prints the list, the ACE Printouts screen reappears. 
 
9. Select Close to return to the contact record screen. 

 
 

 
 
 

7.16.0. Kick Start - Importing Data 

 

ACE allows two paths for importing .The path under File Import on the contact screen is available to all 

users. This approach is used to add data to an existing ACE database.  This approach can import ASCII 
text, dBase FoxPro, Xml, Outlook, Excel files into the currently open database. This approach can also 
import ACE for Windows Client databases and Ace Contact Manager 6.0 contact databases. The second 

path is available in the Ace Administrator environment. The choice "Import Data" in the Ace 
Administrator calls the Ace 6.0 Import Utility for Windows. This utility allows bringing complete 

multiple file (database) "environments" from other contact managers into ACE. This new data brought 
into ACE will destroy the data in the dependent files of a database. Normally these dependent files are 
the Contacts, History, Queries, and Popup files.  

 

7.16.1. Importing from Other Programs. 

 
While particular contact manager product environments will be added in the future to this import utility, 
the Biz*Base and Act Contact manager environments are imported currently. 

 

7.16.2. Windows Configuration 

 

Windows Configuration  Select Windows Configuration from the File Menu. The popup appears 
with Save and switch mode with default and user settings: 
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Windows Configuration means while using ACE 7.1.0 you might have opened some screens, due to 

some urgency you need to close Ace 7.1.0 at that time. You can actually save your opened screens 
through user settings or default settings. Once you come back and open the ace 7.1.0 it opens with the 

same screens, on what ever you were working! 
 
Save  With this feature, you can make a particular Ace 7.1.0 Window a default setting 

Or user setting 1 or user setting 2.Thus, this window will appear on your screen when you 
start the application. 

 
Switch you can switch to any of the three settings (Default Settings, User Setting1, User 
Setting2) whenever you decide to set a different ACE 7.1.0 window as your load screen 

window. 
 

 

 
 

7.16.3. Save Template 

 

Save Template You can create and save a new template in the database with this facility. 
 
 

 
 

7.17.1. How to Create New Databases 

 

New Database->Ace 7.1.0 allows creating multiple databases with your own name and template of your 
choice, you can also password protect your database and you can save the database in your own desired 

location with in Acedata. 
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7.17.2. Additional Databases 

 
Additional databases->Once you create multiple databases all those things will be present in Additional 

database form where you can select the database, Edit the database, delete the database and also you can 
search for the location where it is located.  

 

 
 
7.17.3. How to send group emails 

 
Write menu->Email Merge-merge with current group form will open where you can send email to group 

of people.  
 

To get a group: Lookup->Query by example, here you can do a query so that group of records will be 
created through these you can send email to groups. 
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7.17.4. Query on Emails 

 

File menu->Email->Inbox->mail manager form will open where you can see all inbox, outbox and sent 

items details. You can search for the information by giving your own query string and click on set.  

 

7.17.5. Copy Contact 

 

Edit Menu-> Copy contact 
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1. Duplicate Contact Record: User can create the duplicates of records; with already he has 
with this facility. Click on Duplicate Contact record will pop up Contact information 

form with the duplicate data where in you can save has it is or u can edit any information 
u want and save it. 

 

2. Copy to other database: Here you can copy any record present in one database to another 
database it will create a copy of that record and also you can copy the group of records by 

creating sub groups. 
                     

3. Move to other database: Here you can Move the record from one database to other 

database (here it will remove from source database and add to destination database) and 
also you can move the group of records by creating sub groups. 

 
 

 

 

7.17.6. How to do reverse Query 

 

Lookup->Reverse Query 

Once you do the query u will get some group of records, if you want the records other than queried 
group of records click on Reverse query which will give non queried records. 

 
7.17.7. WinFax Pro link 

 

Write MenuWinfax 
If you have WinFax Pro installed on your computer, ACE 7.1.0 can use it to send faxes.   

 
 

Note: The WinFax Pro Link assumes that your fax number is the second number in the list of phone 

numbers in the upper right corner of the ACE contact Record screen.   
 

 

To use WinFax Pro to send one fax:  

 

 Move to the contact record to send a fax to.   

 Select Write | WinFax (Single Record) The Historical Correspondence Information 

record appears.   
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 If desired, select Create a Historical Record to add this event to the history for this 

contact.   

 Enter a description for the history record.  This line will also appear as the subject of the 

fax.   

 Enter notes in the memo field for the history record, if desired.  This will appear as 

"Cover Text" on the cover sheet of the fax.   

 Select Continue to initiate the link between ACE 7.1.0 and WinFax Pro. The ACE 7.1.0 

to WinFax Link box appears.   

 Make changes to the Subject, and Cover Text, if desired.  Enter a Billing Code or 

Keywords that will be stored in the history in WinFax Pro.   

 Select Continue to launch WinFax Pro. WinFax Pro is launched and the send box 

appears, showing your contact as the recipient of the fax.   

 Select a cover page and any attachments, and then send the fax using the send command 

in WinFax Pro.   

 When you are finished, close WinFax Pro and return to ACE 7.1.0.   

 
To use WinFax Pro to merge faxes:  

 

 Set a query to find the records with fax numbers to be recipients of the fax.   

 Select Write | WinFax (Current Group) The Historical Correspondence Information 

record appears.   

 If desired, select Create a Historical Record to add this event to the history for this 

contact.   

 Enter a description for the history record.  This line will also appear as the subject on 

each of the fax cover sheets.   

 Enter notes in the memo field for the history record, if desired.  This will appear on the 

cover sheet of the fax.   

 Select Continue to initiate the link between ACE 7.1.0 and WinFax Pro.  The ACE 7.1.0 

to WinFax Link box appears.  Each of the names from your query that have a fax 
number will appear as they are sent to WinFax Pro.   

 Make changes to the Subject, and Cover Text, if desired.  Enter a Billing Code or 

Keywords that will be stored in the history in WinFax Pro.   

 Select Continue to launch WinFax Pro. WinFax Pro is launched and the send box 

appears, showing your list of contacts as the recipients of the fax.   

 Select a cover page and any attachments, and then send the fax using the send command 

in WinFax Pro. Each fax will be added to the send queue.   

 When you are finished, close WinFax Pro and return to ACE 7.1.0.   

 

8.0.0. Compress 
 

Compress is one of the rebuild options in Ace.  Compress a database to remove any deleted records, and 
free the space taken up by those deleted records.  After a file is compressed, it is reindexed, greatly 

improving access speed and performance.   
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9.0.0. Migration                                                                                                                      
 
9.1.0. Migrating data of Ace Contact Manager Releases 6 to Ace 7.1.0 

 

1. Ace 6.0 users must ensure they install Ace 7.1.0 in the directory D:\Program Files\Ace Contact  
    Manager 7, C:\AceDMAC, is where Ace 6.0 is located. No other upgrade action is required. In the 

    main Contact Manager Window, click on FileData       
 AdministrationImport Old AceData as shown below. 
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2. In the next step, a popup appears which asks for the confirmation of migration 

from the user and also informs the user that all other users must logout. Click 
on the Yes button. 

 

 
 

 

 

 

 

3. The following popup appears which informs the user to select the type of migration; Automatic or 
    Manual. After selecting, click on the OK button. 
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4. Selecting the Type of Migration takes you to the Locate AceData folder. Click on the Browse button. 

 
 

 
                                                                                                                                                               
5. Browse for the precise folder and the click on the Ok button. 
 

 
 

 
 

 
6. After you click the OK button, the folder path is set into the Locate Ace Data popup. Click on 

the OK button 
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 After you click on the OK button, the following popup appears which informs that ACE6 

data has been successfully migrated to Ace 7.1.0.Click on the OK button. 
 

 

 
                                                                                                                                          

After click Ok, this final popup appears which mentions that Ace 7.1.0 will now close. Click 
on the Ok button to close. 

 

                                                          
 

 

Thus the process of migrating data from Ace6 to Ace 7.1.0 has been explained. 

  

Upon the release of Ace 6, DMAC will no longer support previous versions of Ace Contact Manager. 
 

 

9.2.0. Migrating data of Ace Contact Manager Releases 4.0 and 5.0 to Ace 6 

 
Ace 5.0 users must ensure they install Ace 6 in the same directory, C:/AceDMAC, in which Ace 5.0 is 
located. No other upgrade action is required. 

 
Ace 4.0 users must first install Ace 6 and then perform a simple file copying procedure which will 

ensure that Ace 4.0 files are accessible by Ace 6. 
 
The default installation folder of Ace 4.0 is C:/Program Files/AceWin. Default installation of Ace 5.0 

and Ace 6 is in C:/AceDMAC. For Ace 6 to access Ace 4.0 files, the files must be copied from the Ace 
4.0 default installation folder to the Ace 6 default folder. This guide explains how to do this, assuming 

installation of the respective Ace versions has been to the default folder. (As stated above, Ace 6 will be 
automatically installed in the same folder as Ace 5.0, so no further action is necessary.) 
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1. Using Windows Explorer, view the folders in the drive on which Ace is installed. In this example, 

Ace 4.0 is installed in C:/Program Files/AceWin and Ace 5.0 is installed in C:/AceDMAC. 
 

                      
 

                                                                                                                                                                

 

2. Click on the plus signs to the left of the AceWin and AceDMAC folders. This will display all of  the 
sub-folders under these two folders. Next, click on the AceWin folder. In the right-hand window you 

will see all of the folders and files under the AceWin folder. 
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3. Highlight the sub-folders in the AceWin folder by clicking on the first folder, “data,” then holding 

down the Shift key and clicking on the last folder, “users.” 
             

                   The folders should now look like this 
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4. Place the mouse pointer over the highlighted group of folders, press down and hold the RIGHT mouse   

button and drag the group of folders to the AceDMAC/AceData folder. Hold the mouse pointer over        
the AceData folder and release the button. 

 
 
 

                            
  

 

 

 

 

5. Be sure the mouse arrow is positioned exactly on the AceData folder. When you release the RIGHT 
mouse button, the menu shown below pops up. Click in the, “Copy Here,” option and all of the folders 
and their contents will be copied to the AceData folder. 
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6. Now a confirmation pop-up will ask if you want to replace existing files. Click on, “Yes to All.” 

 

                        
           
 
 

 
    Once the folders and contained files from in the AceWin folder have been copied to the 

AceDMAC/AceData  folder, all data from Ace 4.0 should be accessible to Ace 6. If you have problems 
completing this operation,  please call: 800-667-4695 
 

 

10.0.0. Rebuild Index 
 
Rebuild your databases to keep your data happy and healthy Reindex your files on a weekly basis, and 
compress them whenever you delete records, or biweekly. 

 
To rebuild your databases: 

 

1. Select the files to rebuild.  All files marked with will be rebuilt.   
2. Choose Reindex to keep deleted records in the files, and recreate the indexes or, Choose Compress to 

remove deleted records and recreate the indexes. 
For a description of each of the databases, select the file in the illustration at right.   

You do not have to reindex all of your files every time you rebuild. If you make all of your phone calls 
for the day, and then move them to the history file, a quick compress of the events database will clean up 
and reindex the events database, freeing the space taken up by deleted records 
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11.0.0. ACE Restore Backup 
 
 

1. In the main Ace7.1.0 Contact Manager Window, Click on FileData 

AdministrationRestore Backup. 
 
 

 
 

 
 
 

 

2. Go to the installation path, select AceBackup in AceZips folder and click on the Open 
button. 

 
 

 
 



ACE Contact Manager 7.1.0 User Manual                                                                            

ACE7  

 

156 

                                     
 

 

3.  “A Load Restore from File” popup appears. Click on the Yes button. 
 

 
 

                                    
 

 
 

12.0.0. Taking Backup of Ace data 
 

1. Click on FileData AdministrationBack up in the Ace contact Manager main window. 
 

 

 

 
 

 

2. Go to the ACEZips folder and save as Ace Backup. 
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4. You get a warning popup message which mentions that all users must log off Ace 
during Back up. Click on the OK button. 

 
 

                                   
 

 

                     5. The Create Backup File popup appears. Click on the Yes button. 
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13.0.0. Upgrading ACE 

 
 

Existing Users of ACE6  
 

To upgrade to ACE 7.1.0, just install ACE 7.1.0 to a different installation directory. ACE 7.1.0 will be 

installed with the demo database. You need to migrate your ACE6 data to ACE 7.1.0 to continue 
working in ACE 7.1.0. To know how to migrate data from ACE6 to ACE 7.1.0 – please refer to 

Migration 
 

 

 

Existing Users of ACE7 
 

If you already have a version of ACE7 and you want to reinstall the latest version of ACE 7.1.0, then 
you need to uninstall the currently installed ACE7 through Control panel->Add/Remove programs and 

reinstall ACE 7.1.0 afresh. Before uninstalling – please note the previous installation directory of ACE7. 
When you un-install, ACE7 does not delete the AceData. You need to re-install ACE 7.1.0 to the same 

installation directory so that you can use your existing data. In case, you want to install ACE 7.1.0 to a 
different directory, you will have to take a backup of the existing data from ACE7 before you uninstall. 
You will have to then restore this data to new ACE 7.1.0 after you re-install. If you are trying to reinstall 

ACE 7.1.0 without uninstalling ACE7, and then a new pop appears which provides you with the option 
of: Checkout the screen below. 

 

1. Modify  
2. Repair  

3. Remove.  
  

However there is no scope to reinstall ACE7 to another path in this method. 
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14.0.0. Restrictions of operations for client server installation 
 

Following are the list of restrictions for client server installation. 
 

1. Admin should not try to login from the machine where Ace 7.1.0 is installed as a client 
    because it might corrupt the database. 
 

2. From hereafter client can not create new database. Only admin can create new database. 
 

3. Admin can take Backup, Restore backup, Rebuild indexes and Change the Database  
    structure and import Old Ace Data (File menuDatabase Administration), whereas client  
    is not allowed to do those functionalities. 

 
4. Admin can create new users (File menuUser administrationAce Users) whereas client 

     is not allowed to create users. 
 
5. Admin can edit the user info details from the Preferences (Edit menuPreference),  

    whereas client is not allowed to change the User info details. 
 
6. Ace data should present in Admin Machine only. 

 
7. Only one user should be created as Admin. Admin can perform field label definition and  

                      global replace functionalities (Edit menuField Label or Global Replace) whereas client  
                      is not allowed to perform those functionalities. 

 

 
 

 

SSGINDIA Software End-User License 
 
 

 
The Ace Contact Manager Software contained herein is licensed in accordance with the following terms and conditions. If you 
do not agree to these terms and conditions, select "NO" below and this installation will terminate. If you agree to these terms 
and conditions, select "YES" below and the installation will continue. 
 
LICENSE 
 
SSGINDIA grants you a non-exclusive, non-transferable license to use the enclosed Ace Contact Manager software for a trial 
usage of 30 contacts and three users solely for your own internal needs on the computer on which this installation is being 
executed. You assume entire responsibility for the selection of Ace Contact Manager Software to achieve your intended 
results and for the installation, use and results obtained from Ace Contact Manager Software. Neither the license granted 
under this Agreement nor the Ace Contact Manager software to which it applies may be as signed, sublicensed or otherwise 
transferred by you without the prior written consent of SSGINDIA. 
 
OWNERSHIP AND SECURITY 
 
SSGINDIA is the sole owner and developer, as well as the authorized distributor of Ace Contact Manager Software. All right, 
title and interest in Ace Contact Manager Software, wherever resident and on whatever media, as well as Ace Contact 
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Manager Manuals shall remain with SSGINDIA. You expressly agree to take all reasonable steps necessary to protect the 
proprietary nature of Ace Contact Manager Software against any unauthorized use and disclosure. You further agree not to 
remove or modify any trademarks, proprietary legends or copyright notices for Ace Contact Manager Software and manuals.  
 
RESTRICTIIONS ON COPYING, MODIFICATION AND USE 
 
You agree not to copy, modify, enhance or translate Ace Contact Manager Software or manuals without the prior written 
consent of SSGINDIA. You further agree not to disclose, publish, transfer, translate, release or otherwise make available Ace  
Contact Manager Software or manuals, in any form, to any entity, without the prior written consent of SSGINDIA. 
 
 
LIMITED WARRANTY 
 

Ace contact manager software is provided "AS IS" without warranty of any kind, either expressed or implied , including but not 
limited to the implied warranties OF merchantability and fitness for a particular purpose. The Software and the related 
documentation are provided to the Licensee "AS IS." Licensor makes no warranties, express or implied and expressly 
disclaims and excludes to the maximum extent .Permitted by applicable law, all limitations, oral or written, terms, conditions 
and warranties, including without limitations, implied warranties of merchantability, fitness for a particular purpose, satisfactory 
quality and no infringement without limiting the others , Licensee accepts that the software may not meet  Licensee’s 
requirements, operate error-free, or identify any or all errors or problems, or do so accurately. LICENSEE USES THE 
SOFTWARE AT HIS/HER OWN RISK.  

This Agreement does not affect any statutory Rights Licensee may have as a consumer.  
 
SSGINDIA DOES NOT WARRANT THE FUNCTION CONTAINED IN ACE CONTACT MANAGER SOFTWARE WILL BY 
UNINTERRUPTED OR ERROR FREE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF ACE CONTACT 
MANAGER IS WITH YOU. SHOULD ACE CONTACT MANAGER SOFTWARE PROVE DEFECTIVE, YOU, AND NOT 
SSGINDIA, ITS SUPPLIERS, DISTRIBUTORS OR DEALERS, ASSUME THE ENTIRE COST OF NECESSARY SERVICING, 
REPAIR OR CORRECTION. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MANY ALSO HAVE 
OTHER RIGHTS THAT VARY FROM STATE TO STATE. 
 
LIMITATION OF LIABILITY 
 
 
LIMITATION OF LIABILITY TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL 
LICENSOR'S LIABILITY EXCEED THE LICENSE FEE PAID BY LICENSEE OR US$5.00, WHICHEVER IS GREATER. THIS 
LIMITATION OF LIABILITY AND RISK IS REFLECTED IN THE PRICE OF THE SOFTWARE. NOTWITHSTANDING THE 
FOREGOING, NOTHING IN THIS AGREEMENT SHALL EXCLUDE OR LIMIT LICENSOR'S LIABILITY TO LICENSEE FOR 
ANY LIABILITY THAT CANNOT, AS A MATTER OF APPLICABLE LAW, BE EXCLUDED OR LIMITED.  
 
In no event will SSGINDIA be liable to you for any damages, including any lost profits, lost savings or other direct, indirec t, 
incidental or consequential damages arising from the use of, inability to use or the result of using Ace Contact Manager 
software, even if SSGINDIA has been advised of the possibility of such damages or any claim by any party. Some states do 
not allow the exclusion or limitation of liability for incidental or consequential damages in ce rtain circumstances so this 
limitation may not apply to you. 
 
 
TERM 
 
 
This license is effective for usage with 30 contacts and three users upon your installation of this evaluation version of the  
software and shall automatically terminate if you breach any of the terms and conditions herein. Upon such breach, you shall 
destroy all copies of Ace Contact Manager Software and manuals in whatever form and media and discontinue using Ace 
Contact Manager Software. Upon registering with SSGINDIA this license usage terms are modified to agree with the 
registered number of users and an unlimited number of contacts. 
 
MISCELLANEOUS 
 

 You agree to pay any tax assessed upon Ace Contact Manager Software, this license or the use of same. You 
acknowledge that you have read and understand this software license agreement and agree to be bound by its terms 
and conditions. Furthermore, you agree that this agreement expresses the entire agreement between you and 
SSGINDIA and supersedes any prior communications, oral or written, re lating to the subject matter hereof. 
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 INDEMNIFICATION BY ACCEPTING THIS AGREEMENT, LICENSEE AGREES TO INDEMNIFY 
AND OTHERWISE HOLD HARMLESS LICENSOR, ITS OFFICERS, EMPLOYEES, AGENTS, 
SUBSIDIARIES, AFFILIATES, SUPPLIERS AND OTHER PARTNERS FROM ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES ARISING 
OUT OF, OR RELATING TO, OR RESULTING FROM LICENSEE'S USE OF THE SOFTWARE OR 
ANY OTHER MATTER RELATING TO THE SOFTWARE. 

 

 Termination. Licensor may immediately terminate this Agreement and the license granted hereunder if Licensee fails 
to comply with the terms and conditions of this Agreement. Upon such termination, Licensee must immediately cease 
using the Software, destroy or delete all copies of the Software and upon the request of L icensor, certify the 
destruction or deletion of the Software. Licensee may terminate this Agreement and the license granted hereunder at 
any time by destroying or deleting all copies of the Software. 

 

 ALL DISCLAIMERS, LIMITATIONS OF LIABILITY AND ANY OTHER PROVISIONS INTENDED TO SURVIVE 
TERMINATION WILL SURVIVE ANY TERMINATION AND CONTINUE IN FULL FORCE AND EFFECT. 
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